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New generation of structural reinforcement systems for concrete structures 

Abstract 

 

Civil engineering has an important role in our society, which is constantly demanding for innovative and 

sustainable products. It is the civil engineer duty to design efficient infrastructures capable of promoting 

the sustainability and durability of works of art. Over the last few years, studies in this sector have focused 

on the use of fibre reinforced polymer reinforcements, which was the subject of this work. 

Corrosion of steel reinforcement is a well-known weakness that can compromise the safe use of reinforced 

concrete (RC) structures. This leads to the need for rehabilitation and reinforcement of the built heritage, 

whose costs are, in many cases, so high that demolition is the only option with the consequent harmful 

economic, social, and environmental impacts. The preparation and assembly of conventional 

reinforcement has a significant impact in final cost, and these tasks are always associated with accidents 

involving workers. Thus, the present thesis aims to combine recent developments in the area of fabrication 

of fibre reinforced polymer (FRP) with those in the area of fibre reinforced concrete (FRC), to develop an 

alternative reinforcing system for reinforced concrete. 

In this dissertation, a 12m length single span beam for an office building with BCR (braided composite 

rods) of glass fibre strands, and SFRSCC (steel fibre reinforced self-compacting concrete) was studied. 

The evaluation of the behaviour of this structural system was performed based on the finite element 

method (FEM). In the first phase, three series of shallow beams failing in bending were tested to evaluate 

the potential of the numerical analysis on capturing the experimental results. The second phase focused 

on the conception of the numerical I beam model and subsequent analysis of the behaviour in bending. 

The main conclusions are presented. 

 

 

 

 

KEYWORDS: Fibre reinforced concrete (FRC); BCR; Service limit state; Numerical modelling; Glass fibre 

reinforced polymer (GFRP). 
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Nova geração de sistemas de reforço estrutural para estruturas de betão  

Resumo 

 

A Engenharia civil tem atualmente um papel muito importante na nossa sociedade, a qual exige e 

necessita constantemente de produtos inovadores e sustentáveis. Cabe ao Engenheiro Civil dimensionar 

infraestruturas eficientes capazes de promover a sustentabilidade e durabilidade do ambiente construído. 

Ao longo dos últimos anos têm sido efetuados notáveis desenvolvimentos na utilização de materiais 

compósitos de matriz polimérica para o reforço de estruturas de betão, os quais serão tema neste 

trabalho. 

A corrosão das armaduras de aço é uma das maiores causas de patologias observadas nas estruturas 

de betão armado. Tal facto leva à necessidade de intervenções de reabilitação e de reforço do património 

construído, cujo custos são, em muitos casos, tão elevados que conduzem à opção pela demolição, com 

os consequentes impactos económicos, sociais e ambientais. O tempo de preparação e montagem das 

armaduras convencionais a aplicar em elementos estruturais de edifícios tem peso significativo no custo 

final destes, e a estas tarefas estão sempre associados o maior número de acidentes ocorridos com 

trabalhadores. Assim, na presente tese são realizados estudos combinando os recentes 

desenvolvimentos na área do fabrico de polímeros reforçados com fibras (FRP) com os desenvolvimentos 

na área do betão reforçado com fibras (FRC), de forma a constituir um sistema de reforço alternativo às 

soluções tradicionais em betão armado. 

Na presente dissertação, uma viga de secção I com vão de 12m, projetada para um edifício de escritórios, 

reforçada com varões compósitos entrelaçados (BCR) de fios de fibra de vidro (GFRP) e betão 

autocompactável reforçado com fibras de aço (SFRSCC) foi estudada. A avaliação do comportamento 

deste sistema estrutural realizou-se com recurso ao método dos elementos finitos. Numa primeira fase, 

três séries de lajes de baixa espessura sujeitas a flexão foram estudadas de forma a avaliar o potencial 

da simulação numérica em capturar resultados experimentais. Numa segunda fase procedeu-se à criação 

do modelo numérico da viga, a simulação do ensaio á flexão da viga e posterior análise. As principais 

conclusões são apresentadas. 

PALAVRAS-CHAVE: Betão reforçado com fibras (FRC); BCR; Estado Limite de Serviço; Modelação 

numérica; Varões de fibra de vidro (GFRP). 
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Chapter 1 

1. Introduction 

1.1. General 
 

Reinforced concrete (RC) structures are being challenged every day to become more innovative, and 

rehabilitation is becoming increasingly necessary. For RC structures to have controlled durability, it is 

critical to pay attention to the design phase, so that no large-scale maintenance, repair, or reinforcement 

efforts are required, at the very least during the lifetime of the project. This problem brought up the 

attention of civil engineers towards alternative construction systems. 

Traditional RC systems satisfy the structural needs of design, however, nowadays these needs are 

growing, the building architecture is a lot much diverse, the construction locations are difficult to access 

and in hostile environments, the design method and construction process is different, and the biggest 

difficulty is the lack of manpower. The use of composite materials is the next step to build strong, long-

lasting projects and achieve greatness in construction. 

A composite material that has been studied to substitute conventional steel reinforcement is glass fibre 

reinforced polymer (GFRP). The advantages of fibre reinforced composite materials over conventional 

steel include excellent corrosive resistance, high strength-to-weight (10 times higher than steel), excellent 

fatigue resistance, nonmagnetic properties, and low thermal expansion. 

Commonly used concrete mix compositions does not include steel fibres. This is one difference between 

traditional and advanced reinforcement for concrete structures. Steel fibre reinforced self-compacting 

concrete (SFRSCC) is one alternative for traditional reinforcement. The randomly distributed discrete 

fibres increase concrete post-cracking tensile capacity, guarantee ductility, energy absorption and impact 

resistance when compared to plain concrete. The fundamental reinforcement mechanisms of fibres 

consist in the capacity of ensuring relatively high stress transfer between the faces of the cracks, by 

restraining the degeneration of micro-cracks in meso and macro-cracks, which increases the load carrying 

capacity and stiffness of concrete structures in their cracking stage [1]. 

Additionally, the use of SFRSCC and GFRP could also be used to enhance the structural performance of 

RC elements at Serviceability and Ultimate Limit States (SLS and ULS). Furthermore, to optimize the 
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reinforcing capabilities and to increase the beam's ductility the addition a certain prestress level is an 

option. 

 

1.2. Motivation and objectives 

 

The main objective of this dissertation is to study the application of high-performance materials such as 

SFRSCC and GFRP bars in construction. The advantages of prestressing both GFRP and steel 

reinforcement for the design of structural systems is also studied. Furthermore, this dissertation 

emphasizes the development of numerical simulations for structural design purpose. 

Throughout this dissertation the potential of numerical models was studied and a hypothetical case study 

with a new reinforcing system that combines the benefits provided by the application of SFRSCC and 

hybrid GFRP-steel reinforcements was developed. This case study is about a 12m length single span 

prefabricated I beam for an office building. 

The composite materials used in the design of the beam are studied to be applied so that the best 

performance of the project is achieved. The structural behaviour is demonstrated through numerical 

simulations using structural analysis software’s capable of simulating adequately the non-linear behaviour 

of the materials involved. 

In summary, the present work aims to achieve the following objectives: 

✓ Discover the advantages of using of composite materials in modern construction. 

✓ Study the behaviour of SFRSCC and GFRP in bending. 

✓ Perform numerical simulations for predicting the behaviour of a representative structural element 

made by these materials. 

✓ Comparison between experimental and numerical results. 

 

1.3. Outline of the thesis 

 

The present thesis is divided in seven chapters and is organized as follows: 
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Chapter 1, introduction, is intended to present, in a brief way, the content of the dissertation, justifying 

the motivation of this research, and setting out the objectives to be achieved. 

 

Chapter 2, state of the art on high performance materials for structural systems, a literature review 

analyses the evolution of the understanding of the performance of FRC and FRP in structural systems, 

highlighting the main properties and advantages of using composite materials in structures. The bond 

behaviour between FRC and FRP’s is appraised and a description of some of the relevant material 

parameter’s behaviour is also included. 

 

Chapter 3, description of the experimental programme developed to characterise the behaviour of the 

structural elements studied in the dissertation. The bond between GFRP and surrounding Steel Fibre 

Reinforced Self Compacting Concrete (SFRSCC) is assessed by performing pullout bending tests. The 

influence of concrete cover thickness and anchorage length of the GFRP bars in bond behaviour is 

investigated. 

 

Chapter 4, modelling of bond behaviour between GFRP and SFRSCC using computer programs, FBL and 

FEMIX, respectively. The models are validated with the experimental program results obtained in Chapter 

3 and the bond-slip relationship defined. 

 

Chapter 5, numerical simulation of shallow beams. The calibration of the numerical models is assessed 

and the investigation of the influence of reinforcing shallow beams with GFRP and prestressed steel wires 

is carried out. In the simulations GUID software was used for generating the data file of FEMIX, which 

was the software adopted for structural analysis. The results from FEMIX can be presented with GID 

visualisation facilities. The main objective of the numerical modelling is to determine the constitutive 

model of the intervening materials in the experimental work because it is by means essential for the 

numerical modelling of I beams in the next chapter. 

 

Chapter 6, development of a Case Study with prefabricated I beams. Design, and creating a finite element 

model of the I beam with conventional reinforcement and new reinforcing systems. Five beam bending 



 P a g e  | 4 

 

UNIVERSITY OF MINHO  Diogo Lourenço Fernandes 

test numerical simulations are carried out to study the performance of the new system and the main 

results, especially in terms of the serviceability limit states. Also, the influence of the GFRP-SFRSCC bond 

conditions on force-deflection response of I-shaped cross-sectional beams is studied, allowing the slip 

between the GFRP bars and the surrounding concrete and assuming perfect bond between the concrete 

and the reinforcement. 

 

Chapter 7, A brief resume of conclusions and a summary of results of the present work is presented. 
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Chapter 2 

2. State of the Art on High Performance Materials for Structural Systems 

2.1 Introduction 

 

The growing demand for efficient building structural system with desired levels of performance and safety 

led to accelerated research in sustainable materials, some of them form part of the microstructure of 

concretes. The use of high-performance materials and advanced structural systems provides new 

opportunities to meet global challenges, particularly in civil engineering. 

Chloride and carbonation induced corrosion of steel is a well-known weakness that can compromise safe 

use of reinforced concrete (RC) structures specially in construction close to the coast or in other harsh 

environment [2]. When steel corrodes, the resulting rust increases the steel bar volume and this expansion 

creates tensile stresses in the concrete, which can eventually cause cracking, delamination, and spalling. 

This leads to the need for interventions and rehabilitation, whose costs are, in many cases so high that 

demolition is the only option with the consequent harmful economic, social, and environmental impacts. 

There has been an increasing demand for alternative materials and reinforcement to replace usual steel 

utilizations. Carbon-fibre reinforced polymer (CFRP), aramid fibre-reinforced polymer (AFRP) and glass 

fibre polymers (GFRP) have recently been studied and received a great deal of interest in these subjects. 

The nonmagnetic properties, high strength-to-weight, low expansion, and excellent corrosive resistance 

are some of the characteristics and advantages of this type of materials. Corrosion resistance is 

particularly attractive for designers. The use of FRP as structural reinforcement may offer life-cycle cost 

benefits for certain structures as maintenance to repair corroded reinforcement is not necessary. 

Among the fibre reinforcements, Glass fibre-reinforced polymer have received increasing attention due to 

the low cost compared to carbon fibre reinforcements with good high-cost efficiency [3]. GFRP bars show 

high tensile strength, superior corrosion resistance than steel bars, high strength-to-weight ratio (10 times 

higher than steel), nonmagnetic properties and low thermal expansion. GFRP bars are currently a cost-

competitive alternative to stainless steel bars that are also used in structures where corrosion of 

reinforcement is a concern and offers many advantages to the designer [4]. 

The developments on combining FRP’s and fibre reinforce concrete (FRC) holds major benefits, because 

the additional strain capacity allows an increase in flexural strength over the equivalent conventionally 
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reinforced structures, with beneficial consequences in terms of SLS and ULS design verifications. Also, a 

more rational use of FRP bars in the tension zone can be reached. There are different types of FRC, that 

can be classified in the main two classes, tensile strain-softening and tensile strain-hardening fibre 

reinforced concrete (SSFRC and SHFRC, respectively), whose main difference is the capacity to develop 

an increase of its tensile capacity after crack initiation, up to a relatively high level of tensile strain [5]. 

SHFRC contributes significantly to improve the durability of concrete structures due to its quite high post-

cracking tensile strength and energy absorption capacity. This performance of SHFRC can also be used 

for increasing the shear resistance, limit the crack width, and assure ductile failure modes [6]. The 

materials used in SHFRC depend on the desired characteristics and the availability of suitable economic 

materials. Conventional fibre reinforced concretes (SSFRC) have coarse aggregate particles and large 

steel fibres, and on the other hand the modern types of high-performance fibre concrete have small 

aggregate particles and fillers, reinforced by fine, short fibres. Relatively high content of discrete fibres 

are used in the production of SHFRC, sometimes with more than one type of fibres [7], in order to assure 

its strain hardening character and high level of deformability, which promotes the formation of diffuse 

crack patterns, with benefits on the durability of a RC structure since corrosion is limited. 

 

2.2. Fibre Reinforce Polymer (FRP) 

 

The need of finding an attractive competitor to the conventional civil engineering materials for the creation 

of new structures and strengthening/rehabilitation of existing ones led to a growing awareness amongst 

civil/structural engineers on the importance of the unique mechanical and in-service properties of fibre 

reinforced polymer (FRP). This versatile engineered material, valued for its ability to resist corrosion and 

weather effects and incur very little maintainers costs over time, performs very well in a wide range of 

applications. FRP composites are nowadays used in aircraft, spacecraft, satellites, ships, submarines, 

automobiles, chemical processing equipment, sporting goods and civil infrastructure, and there is the 

potential for common use in medical prothesis and microelectronic devices.  

Fibre reinforced polymers consist mainly in synthetic-based materials, mostly polyester or epoxy resins, 

as well as non-metallic reinforcing fibres embedded in them like glass, aramid or carbon fibres. Wet lay-

up (sheets and fabrics) and prefabricated strips (designed by laminates) and bars are the main types of 

FRP strengthening systems available in the market [8]. The most common strengthening technique is 
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based on the application of the FRP on the surface of the elements to be strengthen and is designated 

as externally bonded reinforcement (EBR) technique. Another technique where FRP’s are used is the near 

surface mounted (NSM), which consists of installing the FRP reinforcement in a groove cut into the 

concrete surface. One solution to the corrosion problems of steel reinforcement is the use of FRP rods 

[9], thus the investigation of the bond behaviour of FRP bars to concrete is an important aspect of this 

alternative reinforcing system. 

The applicability of FRP reinforcements to concrete structures offers several advantages, however, these 

materials generally have a linear elastic response in tension up to failure (described as a brittle failure) 

and a relatively poor transverse or shear resistance. They also have poor resistance to high temperatures 

[10]. Moreover, their cost, whether considered per unit weight or on the basis of force carrying capacity, 

is high in comparison to conventional steel reinforcing bars or prestressing tendons. It is expected that 

the costs in future years will decrease with increased demand and market share. 

FRP can be applied to strengthen beams, columns, and slabs in buildings and infrastructures. One 

important factor to consider is that with this material is possible to increase strength of structural 

members even after they have been severely damaged due to loading conditions. Moisture, thermal 

effects and ultraviolet (UV) radiation play a primary role among the environmental conditions identified as 

being of primary importance in terms of durability of FRP composites in infrastructural applications. GFRP 

profiles, for example, are likely to be exposed to rain, humidity or moisture and in some applications, 

such as bridge columns or in harbours, the material may even be immersed [11]. 

 

2.3. Fibre Reinforced Concrete (FRC) 

 

Concrete is a composite material comprising of fine and coarse aggregates bonded together into a cement 

matrix that cures over time. When the aggregate is mixed with dry Portland cement and water, the mixture 

forms a slurry that is easily poured and shaped into mould. Fibre reinforced concrete (FRC) is a composite 

material consisting of fibrous material which increases its structural integrity. It includes mixtures of 

cement, aggregates and discontinuous (short) fibres, whose distribution and orientation depend on the 

geometry of the structural element, casting technology and rheological properties of the FRC. This type 

of concrete is particularly attractive for statically indeterminate structures, since cracking control through 

fibre reinforcement mechanisms provide high levels of stress distribution, improving the load carrying 
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capacity and deformability levels that are higher than the cracking load and its corresponding deformation 

[12]. 

The potentialities of using fibres for an increase in the performance of concrete structures and its 

extensive research is always evolving. Repairing bridge decks, roads, tunnels, marine and aerospace 

structures are examples of the application of this high-performance material. The use of this type of 

materials can potentially decrease the construction time and maintenance costs. Concrete with high levels 

of compressive strength have a proportional increase of the tensile strength and the Young’s modulus 

obtaining better response in tension, especially in the post cracking regime.  

Figure 1 shows the main differences between plain and fibre reinforced concrete having both normal and 

high strength under uniaxial compression. The compressive relations valid for plain concrete apply for the 

FRC as well. 

 

Figure 1 - Difference between plain and fibre reinforced concrete, according to MC2010 [13]. 

 

Tensile strength (𝑓𝑐𝑡), flexural strength, stress-strain behaviour, modulus of elasticity (𝐸𝑐), crack 

formation and propagation and compressive strength (𝑓𝑐) of the FRC are the principal mechanical 

properties studied to verify the qualities of this concrete. 

Steel fibre reinforced self-compacting concrete (SFRSCC) has been widely used in civil engineering 

applications. Optimizing the construction process is one of the main advantages of this composite 

material, as the discrete fibres can promote the partial or total replacement of the conventional 

reinforcement. Self-compacting concrete (SCC) is fresh concrete that compacts on its own without the 
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use of vibrations, promoting faster replacement and less labour, as well as surface finish and durability. 

The influence in the mechanical properties of the concrete, especially in terms of the design application 

is due to a good distribution/orientation of the steel fibres in the mix. 

Among the aforementioned parameters of SFRSCC, the concrete property most benefited by fibre 

reinforcement is the energy absorption capacity. Structures with redundant supports, such as slabs on 

soil and tunnelling lines are protected and more secure because of the increment on the material energy 

absorption capacity, provided by fibre reinforcement. This enhances the cracking behaviour and increases 

the load bearing capacity of these structures [14].  

 

2.4. Three-dimensional system reinforcement textile (3D-SRT) 

 

The idea of interlacing fibres to make fabric has been around for many years. The common right-angle 

weaving technique, known as biaxial weaving or flat weaving, is the model used to develop the principles 

of modern weaving. [15]. 

3D braided assemblies are textile architectures that have fibres oriented so that both the in-plane and 

transverse tows are interlocked to form an integrated structure that might have a similar unit cell in all 

three orthogonal directions [16]. The braiding technique is probably the most ancient production process 

for textile structures and due to the developments in civil engineering, the production of a wide range of 

preforms for composite reinforcements with structural function is possible. 

The advances in the textile industry allowed the manufacturing of relatively sophisticated 3D 

reinforcements, herein designated by 3D-SRT, using textile fibres and can be credited largely to the 

continuous growth of composite materials. Recent automated manufacturing techniques used in 

sophisticated controlled machines have substantially reduced costs and significantly improved the high-

speed and large-volume textile production. A standard horizontal braiding machine used to produce 

braided composite rods (BCR) for production of 3D-SRT reinforcement is presented in Figure 2. 
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Figure 2 - Standard horizontal braiding machine developed by the Fibrous Materials Research Group, at University of Minho 

[17]. 

 

The two dimensional planar or conventional (2D) fabrics composite are reinforced in directions parallel, 

but not orthogonal, to the fabric plane. In this type of reinforcement, the laminated composites should be 

prepared using several fabric layers because the laminated composites are sensitive to failure by 

delamination and have poor shear capacity. 

Reinforcement in the plane normal to the fabric (three orthogonal directions), provided by three-

dimensional (3D) fabrics, enhance composite shear strength, tensile strength and toughness, reduces 

the chance of composite failure and markedly improve the mechanical properties when incorporated in 

cement-based composites [18]. 

3D-SRT (3-Dimensional System Reinforcement Textile) are produced connecting two sets of independent 

2D-SRT mesh together with a third set of rods along the thickness, Z direction, of the fabric, referred as 

spacer rods. These rods provide shear reinforcement and stabilization. Figure 3 shows a manufactured 

3D-SRT reinforcement with Glass fibre spacer rods developed at the University of Minho. 
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Figure 3 - Samples of 3D-SRT reinforcement for slabs [17]. 

 

This information is particularly important because BCR rods (may also be called GFRP bars) will be used 

as reinforcement in experimental and numerical studies during this dissertation. 

 

2.5. Bond behaviour between FRC and FRP bars 

 

Bond performance influences the ultimate load carrying capacity of a reinforced element and typically, 

the bond of a rebar embedded in concrete is assured by the adhesion and friction between concrete and 

rebar. The bond means the transfer of stress between the concrete and the reinforcement, such as steel 

bars, or rods and many other materials, developed at the vicinity of the interface between both materials 

during the load process of reinforced concrete elements. 

Direct pullout test (with centric or eccentric position of bar), splice test, beam test and ring pullout test 

are the most used tests to evaluate bond mechanisms and behaviour. However, the pullout bending test 

is widely used. Concrete cover thickness that refers to the depth of the reinforcement inside the element 

is a parameter analysed in pullout tests. Other parameters used to compare the effectiveness of bond 

are the bar diameter, bar surface treatment and concrete strength. 
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Bond is improved with the confinement applied to the surrounding concrete during the pullout process 

[19]. 

Figure 4 shows the setup for a beam pullout test. 

 

 

 

 

 

Figure 4 - Pullout bending test [8]. 

 

Usually, pullout bending tests have two prismatic concrete blocks connected by a rebar as a flexural 

reinforcement at bottom part, and a steel hinge at top zone, Figure 4. In the front part of each block, in 

a small length the bar is unbonded to avoid premature fracture of the concrete in these zones. During 

the tests, the embedded length is only changed in one block, but a constant embedment length is used 

in the other. Is important to mention that the rebar is covered by approximately 50 mm long plastic tubes 

with low elastic modulus in order to create an unbonded length at the edge. The test is performed under 

displacement control using two LVDT’s. LVDT 1 is supported on the bar closed to the loaded end section 

and measures the relative displacement between this section and the concrete front surface of the left 

block. LVDT 2 is fixed to the free extremity of the bar and measures the relative displacement between 

the free end part of the bar and the concrete rear surface. [6]. 

FRP bars have a different behaviour compared to usual steels bars. The most important difference is that 

FRP reinforcement behaves linearly elastic till failure occurs, whereas conventional steel reinforcement 

shows a plastic stage with large deformation after yielding. Another difference is the material property 

and surface texture, that leads to different surface toughness and force transfer mechanism between the 

reinforcement and concrete. 

When the bond behaviour is being evaluated by pullout bending tests, is fundamental to consider the 

“loaded end slip” that refers to the cross-section of the bar at the beginning of the embedded length 

where the pullout load is applied and also the “free end slip” located at the cross-section of the bar in the 

extremity of the embedded length. These two locations give the best results recording the applied pullout 
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force against the relative slip between the bar and concrete. Results of the embedded bar, − curve 

where  is the bond shear stress typically must be presented. This value is calculated by Eq. (1), where 

 can be defined as an average bond stress [28]: 

 

𝜏𝑚 =
𝐹

𝐿𝑒 ∙ 𝑃𝑟
 

(1) 

 

where, F represents the pullout force, 𝐿𝑒 the embedded length and 𝑃𝑟 the perimeter of reinforcing bar. 

 

2.6. Relation between fibre orientation and post-cracking behaviour in FRC. 

 

In the last decades, fibres of different shapes and geometries are being used as a discrete reinforcement 

to control the crack propagation in the concrete matrix and to improve the post-cracking residual strength 

without extra costs on the propagation and installation of the reinforcement [20]. The fibres prevent that 

micro-crack join forming meso-cracks, and consequently prevents the opening of these cracks towards 

macro-cracks. The energy dissipated on the concrete fracture propagation is the property that takes the 

most benefits from including fibres to the concrete mix, not forgetting that dissipated energy is quite 

dependent on the fibre orientation and distribution [21]. 

To optimize the fibre contribution to the post-cracking behaviour, it is important to enhance the distribution 

and orientation of the fibres at the crack plane [14]. 

Splitting Tensile Tests executed on SFRSCC specimens extracted from panels have demonstrated the 

influence of fibre distribution/orientation on the tensile post cracking parameters and the stress crack 

opening width (σ–ω) relationship [22]. Figure 5 shows both the envelope and average force–crack mouth 

opening response (F–ω) obtained from the splitting tensile tests, when the notch was parallel (ϴ= 0°) 

and perpendicular (ϴ= 90°) to the concrete flow direction: 
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(a) (b) 

Figure 5 – Force–crack opening width relationship obtained from splitting tensile teste for: (a) ϴ= 0° and (b) ϴ=90° [22]. 

 

When the notch is parallel (ϴ= 0°) to the concrete flow direction exhibits a non-linear hardening behaviour 

until the peak load is attained and then follows a softening phase. Contrary to this behaviour, for (ϴ= 

90°) is only observed a softening phase immediately after the crack onset. The preferential fibre 

alignment is perpendicular to the concrete flow direction and is credited by the rather distinct number of 

fibres intersecting the crack plane at the specimen’s notch. 

Figure 6 shows three (F–ω) relationships (on top, average, and bottom) obtained from splitting tensile 

tests for SFRSCC panels for (ϴ= 0°) and (ϴ= 90°) oriented fibres. 

 

  

(a) (b) 

Figure 6 – Nominal tensile stress–crack opening width relationship, σ–w, obtained from splitting tensile test for: (a) θ= 0° 

and (b) θ= 90° [22]. 

 

The readouts of the LVDT’s mounted on the upper surface of the concrete panels shows higher crack 

opening width compared to the one recorded by the LVDT’s mounted at the lower panel surface, see 
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Figure 6. It is important to note that cracks open asymmetrically, this phenomenon can be ascribed to 

the variation of the effective fibres along the depth of the panel due to segregation.  

The stress–crack opening width (σ–ω) relationship is evaluated by uniaxial tensile tests. Figure 7 presents 

the average and envelope force – crack opening width relationship determined by averaging the readouts 

of four LVDT’s for (ϴ= 0°) and (ϴ= 90°). 

 

 

(a) (b) 

Figure 7 – Force–average crack width relationship, F–w, obtained from uniaxial tensile tests for: (a) θ = 0° and (b) θ = 90° 

[22]. 

 

From the analysis of the results, it is possible to conclude that the F–ω curve is almost linear up to the 

crack initiation and when the crack onset the results are similar to what is observed and described in the 

splitting tensile test, for both (ϴ= 0°) and (ϴ= 90°) oriented fibres. The distinct number of fibres at the 

crack plane is again confirmed to be the cause for the two different behaviours in (ϴ= 0°) and (ϴ= 90°). 

In order to characterize the distribution and orientation of fibres parameters it is important to assess a 

suitable experimental procedure [23]. This procedure can be carried out by image processing, where the 

beam is cut into several pieces and the cross-section of the fibres is used to determine their orientation 

and distribution [24]. 

Figure 8 shows the cross section of an exemplary beam used in image processing with the determination 

of the volume of interest (VOI) and image cropping and Figure 9 shows the image analysis procedure of 

a beam specimen using “ImageJ” software to recognize steel fibres. 
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(a) (b) 

Figure 8 – Cross sections of an exemplary beam: (a) image after VOI selection and (b) after steel fibres segmentation [24]. 

 

 
 

(a) (b) 

  

(c) (d) 

Figure 9 – Image processing steps: (a) converting a coloured image to greyscale, (b) adjusting a threshold, (c) defining 

mask, noise and watershed functions, (d) fitting the best ellipse to each fibre [22]. 
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The following equations derive from the image analysis technique that due to its simplicity and relatively 

low cost is used in these matters [22]: 

𝑁𝑓 =
𝑁𝑇
𝑓

𝐴
 

(2) 

 

The number of fibres per unit area, 𝑁𝑓, is the ratio between the total number of fibres counted in the 

image, 𝑁𝑇
𝑓
, and the total area of the image, 𝐴. 

 

The fibre orientation factor,𝜂𝛳, is determined as the average orientation towards a certain plane surface 

by Eq. (3): 

𝜂𝛳 =
1

𝑁𝑇
𝑓
∙∑cos𝛳𝑖

𝑁𝑇
𝑓

𝑖=1

 

(3) 

 

𝑁𝑇
𝑓
is the total number of fibres that can be determined by counting all the visible ellipses and circles at 

the cross section, 𝛳 is the the out-plane angle that is defined as the angle between the fibre’s longitudinal 

axis and a vector orthogonal to the plane. 

 

The fibre segregation parameter, 𝜉𝑠𝑒𝑔 is used to calculate the location of the steel fibres gravity centre, 

an average value of the coordinates in the Y axis of entire fibres should be determined in the analysed 

cross-section. 

𝜉𝑠𝑒𝑔 =
1

ℎ ∙ 𝑁𝑇
𝑓
∙∑ 𝑦̅

𝑁𝑇
𝑓

𝑖=1

 

(4) 

 

where, 𝑦̅ is the coordinate in the Y axis of the fibre’s gravity centre, and ℎ is the height (or depth) of the 

analysed cross-section. 
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2.6.1. Influence of steel fibres on Fracture Energy  

 

The energy absorption capacity is the main material property benefited by fibre reinforcement [25]. 

Fracture energy of SFRSCC is used in constitutive models for characterizing the post cracking behaviour 

[26]. The most appropriate test to evaluate the material fracture energy 𝐺𝑓 is the uniaxial tensile test. It 

requires very high precision measuring devices and a refined control unit. 𝐺𝑓 is defined as the area under 

the load-deflection curve per unit fractured surface area. Three-point notched bending tests are more 

usual than the uniaxial tensile test and give suitable results on the material fracture energy [14]. 

In many studies, it is pointed out that fibres during the crack propagation after matrix cracking, are broken 

or pulled-out of the matrix due to the bond strength between fibres and matrix [14, 27]. 

In the absence of experimental data, the fracture energy 𝐺𝐹 for ordinary normal weight concrete may be 

estimated by Eq. (5), given by the Model Code 2010: 

𝐺𝐹 = 73 ∙ 𝑓𝑐𝑚
0.18 (5) 

 

where, 𝑓𝑐𝑚 = 𝑓𝑐𝑘 + ∆𝑓 is the mean compressive strength and 𝑓𝑐𝑘 is the characteristic compressive 

strength.  

 

For normal weight concrete the fracture energy depends essentially on the water-cement ratio, the age of 

the concrete and the maximum aggregate size. Curing conditions and the size of a structural member 

also have an important effect on experimentally determined 𝐺𝑓 values. It is important to mention that the 

aggregate type and content seem to affect the fracture energy of concrete much more than the size of 

aggregates. 

The force–deflection relationship is used to evaluate the energy absorption capacity of concrete. Figure 

10 shows an example of average force–displacement relationship for 800x100x100 mm beam 

specimens carried out by three-point bending tests [14]. 
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Figure 10 - “Average” force-displacement relationship for series of 30, 60 e 90 kg/m3 of fibres [14]. 

 

The Eq. (6) is used to calculate the maximum stress at notched cross section of beams presented in 

Figure 10: 

𝑓𝑛𝑒𝑡 =
3 ∙ 𝐹𝑚𝑎𝑥 ∙ 𝐿

2 ∙ 𝑏 ∙ (ℎ − 𝑎)2
 

(6) 

 

where, 𝐹𝑚𝑎𝑥 is the maximum load, L=800 mm is the specimen span, b=100 mm and h=100 mm is the 

width and height of the specimen, respectively, and a=25 mm is the depth of the notch. 

 

The results presented in Figure 10 were obtained from tests that considered the specimen dimensions 

for evaluating the fracture energy of plain concrete. For beams reinforced with FRC, tests should be 

performed on beams with a span of 500 mm, a width of 150 mm, a height of 150 mm, and a notch 

depth of 25 mm. 

It is possible to conclude in Figure 10 that the maximum load in series reinforced with 30 and 60 kg/m3 

of fibres is almost the same and significant increase in the maximum stress at the notched cross section 

is only observed on specimens reinforced with 90 kg/ m3 of fibres. There is a decline of force after peak 

load with the increment of fibre content. In specimens with 90 kg/m3 of fibres a hardening branch occurs 

due to the high percentage of fibres bridging the crack surfaces. One of the most important results points 

is that the energy absorption capacity increases almost linearly with the fibre content. 
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The nominal values of the material properties can be determined by performing a 3-point bending test on 

a notched beam according to EN 14651, Figure 11. Parameters, 𝑓𝑅,𝑗, representing the residual flexural 

tensile strength, are evaluated from the force–crack mouth opening displacement (CMOD), as follows: 

𝑓𝑅,𝑗 =
3 ∙ 𝐹𝑗 ∙ 𝑙

2 ∙ 𝑏 ∙ ℎ𝑠𝑝
2 

(7) 

 

where, 𝑓𝑅,𝑗 is the residual flexural tensile strength corresponding to 𝐶𝑀𝑂𝐷=𝐶𝑀𝑂𝐷𝐽, 𝐹𝑗 is the load 

corresponding to 𝐶𝑀𝑂𝐷=𝐶𝑀𝑂𝐷𝐽, 𝑙 is the span length, 𝑏 is the specimen width and ℎ𝑠𝑝 is the distance 

between the notch tip and the top of the specimen (125 mm). 

 

Figure 11 - Test set-up required by EN 14651 (dimensions in mm). 

 

2.7. Shear capacity of FRC beams. 

 

Fibre reinforcements increase the shear capacity of concrete, allows a partial or total replacement of steel 

stirrups without occurring shear failure when suitable level of prestress is applied to the flexural 

reinforcement and is regarded as an extra flexural reinforcement, whose favourable mechanism for the 

shear capacity derives from the dowel effect [28]. Conventional shear reinforcements can be partially or 

totally replaced by steel fibres in concrete depending on the concrete strength class and dosage of steel 
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fibres in the mix. In structures governed by shear, fibre reinforcement increases the strength and stiffness 

of the shear stress across cracks. 

In a traditionally reinforced beam, the main shear strength contributing mechanisms are: 

• Shear strength of compression zone 

• Friction in the crack interface (i.e. aggregate interlock) 

• Dowel action of longitudinal reinforcement 

• Tensile force in stirrups 

To measure shear strength of concrete beams reinforced with FRP’s is necessary to discuss the effect of 

the low modulus of elasticity and the non-yielding characteristics of the FRP. 

The fib Model Code 2010 presents two approaches for determining the shear strength of fibre reinforced 

concrete beams. One is based on the concept of residual flexural strength of FRC and the other is based 

on the modified compression field theory (MCFT) [29]. 

In this section is presented the first approach based on a modification to the Eurocode model [30] and 

the MCFT approach. 

𝑉𝑅𝑑 = 𝑉𝑅𝑑,𝐹 + 𝑉𝑅𝑑,𝑆 (8) 

 

𝑉𝑅𝑑,𝐹 is the component of shear carried by fibres and  𝑉𝑅𝑑,𝑆 is the component of shear due to stirrups. 

 

In MC2010 (chapter 7.7, section 7.7.3), the design value of the shear resistance in structural members 

with longitudinal bars and without shear reinforcement is evaluated by Eq. (9). 

𝑉𝑅𝑑,𝐹 = {
0.18

𝛾𝑐
∙ 𝑘 ∙ [100 ∙ 𝜌𝑠𝑙 ∙ (1 + 7.5 ∙

𝑓𝐹𝑡𝑢𝑘
𝑓𝑐𝑡𝑘

) ∙ 𝑓𝑐𝑘]

1
3
+ 0.15 ∙ 𝜎𝑐𝑝} ∙ 𝑏𝑤 ∙ 𝑑 

(9) 

 

where, 𝛾𝑐 = 1.5 is the partial safety factor for concrete without fibres, 𝑘 = 1 + √
200

𝑑
≤ 2.0 is a factor 

that takes into account the size effect, 𝑑 (mm) is the effective depth of the cross section, 𝜌𝑠𝑙 =
𝐴𝑠𝑙

𝑏𝑤∙𝑑
 is 
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the longitudinal reinforcement ratio, 𝐴𝑠𝑙 is the cross-sectional area of the longitudinal reinforcement, 

𝑓𝐹𝑡𝑢𝑘 is the characteristic post-cracking residual tensile strength of the FRC for shear determined at a 

crack opening displacement (COD) of 𝑤𝑢 = 1.5 𝑚𝑚, 𝑓𝑐𝑡𝑘 is the characteristic value of cylindrical 

compressive strength, 𝑓𝑐𝑘 is the characteristic compressive strength, 𝜎𝑐𝑝 =
𝑁𝑒𝑑

𝐴𝑐
< 0.2 ∙ 𝑓𝑐𝑑 is the 

average axial stress acting in the cross-section (considered positive in compression), for an axial force, 

due to loading or prestressing actions and 𝑏𝑤(mm) is the smallest width of the tensile zone of the cross-

section. 

 

The design shear resistance of structural members with transverse reinforcements is determined by: 

𝑉𝑅𝑑 = 𝑉𝑅𝑑,𝐹 + 𝑉𝑅𝑑,𝑆 ≤ 𝑉𝑅𝑑,𝑚𝑎𝑥 (10) 

 

𝑉𝑅𝑑,𝑚𝑎𝑥 is the maximum shear strength without concrete crushing. 

 

𝑉𝑅𝑑,𝑆 is determined according to Eq. (11): 

𝑉𝑅𝑑,𝑆 =
𝐴𝑠𝑤
𝑆𝑤

∙ 𝑧 ∙ 𝑓𝑦𝑤𝑑 ∙ (cot 𝜃 + cot 𝛼) ∙ sin 𝛼 
(11) 

 

where, 𝐴𝑠𝑤 is the shear reinforcement area, 𝑆𝑤 is the longitudinal spacing shear reinforcing bars and 

𝑓𝑦𝑤𝑑 is the design value of the yield strength of the shear reinforcement. 

 

The shear strength of FRC can be obtained by a recent model, the MCFT model, also implemented in 

MC2010, shown in Eq. (12): 

𝑉𝑅𝑑,𝐹 =
1

𝛾𝐹
∙ [𝑘𝑣 ∙ 𝑓𝑐𝑚 + 𝑘𝑓 ∙ 𝑓𝐹𝑡𝑢𝑘 ∙ cot 𝜃] ∙ 𝑏𝑤 ∙ 𝑧 

(12) 
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𝑓𝐹𝑡𝑢𝑘 is the characteristic post-cracking residual tensile strength of FRC determined from axial tensile 

tests or indirectly from standard three-point bending test results,  𝑘𝑓 = 0.8 is a reduction factor taking 

into account the variation of fibre dispersion and inherent post-cracking performance between three-

point bending test specimen and the actual elements for which the shear design is conducted, 𝑘𝑣 is 

function of the parameter that considers the aggregate size influence, 𝑘𝑑𝑔, and 𝜃 is the inclination of 

the critical diagonal crack.  

 

For reinforced concrete (RC) and prestressed concrete (PC), the longitudinal strain (see Figure 12) is 

calculated at mid depth of the effective shear depth, 𝜀𝑥, as presented in Eq. (13): 

𝜀𝑥 =

{
  
 

  
 

1

2 ∙ 𝐸𝑠 ∙ 𝐴𝑠
∙ (
𝑀𝐸𝑑

𝑧
+
𝑉𝐸𝑑 ∙ cot 𝜃

2
+ 𝑁𝐸𝑑 ∙ (

1

2
±
∆𝑒

𝑧
)) 𝑓𝑜𝑟 𝑅𝐶 𝑏𝑒𝑎𝑚𝑠

(
𝑀𝐸𝑑

𝑧 + 𝑉𝐸𝑑 + 𝑁𝐸𝑑 ∙
(𝑧𝑝 − 𝑒𝑝)

𝑧 )

2 ∙ (
𝑧𝑠
𝑧 ∙ 𝐸𝑠 ∙ 𝐴𝑠 +

𝑧𝑝
𝑧 ∙ 𝐸𝑝 ∙ 𝐴𝑝)

                                      𝑓𝑜𝑟 𝑃𝐶 𝑏𝑒𝑎𝑚𝑠 

 

(13) 

  

Within the limits 0 ≤ 𝜀𝑥 ≤ 0.003 

 

In Eq. (13) 𝑀𝐸𝑑, 𝑉𝐸𝑑 and 𝑁𝐸𝑑 are the design values of bending moment, shear and axial forces acting 

on the cross section, respectively. The bending moment and shear force are taken as positive quantities 

and the axial force is positive for tension and negative for compression. If the strain 𝜀𝑥 is negative 

(compression), it must be taken as zero. 
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Figure 12 - Definition of cross-sectional parameters, internal loads and strain profile according to MC2010 [13]. 

 

The factor 𝑘𝑣 considers both the strain and size effect: 

𝑘𝑣 =

{
 
 

 
 0.4

1 + 1500 ∙ 𝜀𝑥
∙

1300

1000 + 𝑘𝑑𝑔 ∙ 𝑧
 𝑓𝑜𝑟 𝜌𝑤 < 0.08 ∙√

𝑓𝑐𝑘
𝑓𝑦𝑘

  

0.4

1 + 1500 ∙ 𝜀𝑥
                       𝑓𝑜𝑟 𝜌𝑤 ≥ 0.08 ∙√

𝑓𝑐𝑘
𝑓𝑦𝑘

 

 

(14) 

 

𝜌𝑤 represents the transverse reinforcement ratio of the cross section. 

 

The aggregate size parameter in Eq. (15), 𝑘𝑑𝑔, is given by: 

𝑘𝑑𝑔 =
32

16 + 𝑑𝑔
≥ 0.75 

(15) 

 

where, 𝑑𝑔 (mm) is the maximum aggregate dimension in the concrete matrix. If the particle size is less 

than 16 mm, it is suggested to take the value of 𝑘𝑑𝑔 equal to 1. 

 

The design shear resistance cannot exceed the crushing capacity of concrete in the web: 
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𝑉𝑅𝑑,𝑚𝑎𝑥 = 𝑘𝑐 ∙
𝑓𝑐𝑘
𝛾𝑐

∙ 𝑏𝑤 ∙ 𝑧 ∙
cot 𝜃 ∙ cot 𝛼

1 + cot 𝜃2
 

(16) 

 

𝑘𝑐 = 𝑘𝜀 ∙ 𝜂𝑓𝑐 is a strength reduction factor, 𝛼 is the inclination of the transverse reinforcements with 

the longitudinal axis, 𝑘𝜀 is a factor that considers the strain in the web of the structural element and is 

determined according to the level of approximation defined in MC2010 and 𝜂𝑓𝑐 considers the effect of 

more brittle failure for high strength concrete compositions, determined from Eq. (19). 

 

Level of approximation I, 𝑘𝜀 = 0.55, Level of approximation II and II, Eq. (17): 

𝑘𝜀 =
1

1.2 + 55 ∙ 𝜀1
∙ 𝑏𝑤 ≤ 0.65 

(17) 

 

𝜀1 = 𝜀𝑥 ∗ (𝜀𝑥 + 0.002) ∗ 𝑐𝑜𝑡2 𝜃 (18) 

 

where, 𝜀𝑥 is the longitudinal strain level in the mid-depth of the cross section and 𝜃 is inclination of the 

principal compressive stress in the web, relative to the longitudinal axis of the member. 

 

𝜂𝑓𝑐 = (
30

𝑓𝑐𝑘
)

1
3
≤ 1.0  (𝑓𝑐𝑘 𝑖𝑛 𝑀𝑃𝑎) 

(19) 

 

The angle of compressive stress field (𝜃) for FRC is calculated by: 

29° + 7000 ∙ 𝜀𝑥 ≤ 𝜃 ≤ 45° (20) 

 

 

 

 



 P a g e  | 26 

 

UNIVERSITY OF MINHO  Diogo Lourenço Fernandes 

Chapter 3 

3. Bond Behaviour Between GFRP and SFRSCC 

 

The evaluation of structural components should be conducted through experimental programs that give 

relevant information about the main material properties of the intervening materials in the tests. An 

important consideration when evaluating a structural system in this field of study is the flexural behaviour 

of concrete (or FRC). One important key issue to better understand the flexural behaviour is the bond 

mechanism of reinforcing bars as internal reinforcements for concrete members. For this reason, this 

chapter presents an experimental programme on bond behaviour between GFRP bars and steel fibre 

reinforced self-compacting concrete (SFRSCC) by carrying out pullout bending tests. The influence of 

anchorage length and SFRSCC cover thickness in the bond behaviour was investigated. Furthermore, the 

recorded response of the series evaluated on the tests is presented and discussed.  

 

3.1. Experimental Program 
 

In the present experimental program, a total of 18 pullout bending tests were carried out to study the 

bond behaviour of GFRP bars embedded in SFRSCC. The tests were conducted at the laboratory of the 

company CiviTest (Research of New Materials for Civil Engineering) where a report was elaborated and 

supplied by the company. 

 

3.1.1. Materials Properties 
 

The pullout bending specimens were produced from self-compacting concrete reinforced with 60 kg/m3 

of hooked-end steel fibres. The SFRSCC mix is presented in Table 1. Ordinary Portland cement labelled 

as CEM I 42.5 R, fine and coarse river sand and crushed granite gravel aggregate of 4.76 to 12.7 mm 

size were used. The production of the specimen also contained hooked end steel fibres with configuration 

length (𝑙𝑓𝑟) equal to 33mm, aspect ratio (i.e. 𝑙𝑓𝑟 ∅𝑓𝑟 ) equal to 60, and a tensile strength around 1100 

MPa and polymeric fibres of 12mm length. The concrete mixture showed good homogeneity and 

cohesion, and the average spread measured about 750 mm (SF2 Class), Figure 13. 
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Table 1 – Composition of SFRSCC 

Components Quantity (
𝒌𝒈

𝒎𝟑) 

Cement (CEM I 42.5 R) 376.00 
Water 196.20 
Superplasticiser (BASF SK617) 11.516 
Fly ash 200.00 
Fine river sand (0-2.38 mm) 156.21 
Coarse river sand (0-4.76 mm) 782.07 
Crushed grantite (4.76-12.70 mm) 625.86 
Hooked end steel fibers 60.00 
Polymeric fibers 2.00 

 

Four specimens of 600 x 150 x 150 mm and six cubes of 150 x 150 x 150 mm were prepared to evaluate 

the flexural and compressive strength of SFRSCC, respectively. Prior to those tests, four cylinders of Ø150 

x 300 mm were used to determine the Young’s modulus of the self-compacting concrete. The 

compressive strength and the flexural behaviour were assessed after 28 days of concrete casting 

operations. The average values of concrete compressive strength and Young’s modulus were 50.23 MPa 

and 26.74 GPa, respectively. Table 2 summarises the results of the characterization of the concrete used 

to manufacture the test specimens. 

 

 

 

 

 

 

 

 

 

Figure 13 – SFRSCC slump flow test. 
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Table 2 – Results of SFRSCC characterization. 

 ƒƒct,L 
(MPa) 

ƒR,1 
(MPa) 

ƒR,2 
(MPa) 

ƒR,3 
(MPa) 

ƒR,4 
(MPa) 

σ ƒcc 
(MPa) 

Cylinder 1      − − 

Cylinder 2      − − 

Cylinder 3      − − 

Cylinder 4      − − 

Average values 
       

Standard deviation 
       

Percentage standard 
deviation 

2% 12% 11% 13% 18% 2.46% 2.30% 

 

GFRP bars of Ø5mm were subjected to tensile tests to determine their mechanical properties, as shown 

in Figure 14. The tensile test determined the strength, elasticity, and deformability of the composite 

reinforcement. 

 

 

 

 

 

 

 

 

 

 

 

Figure 14 - Example of tensile test on GFRP bar [28]. 
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The obtained values for the Young’s modulus of the GFRP bar were 44.81 GPa and tensile strength of 

945.56 MPa was achieved. As previous mentioned in the State of Art section, the GFRP bars have lower 

modulus of elasticity and inferior bond strength comparing to conventional steel bars.σ 

 

3.1.2. Pullout bending test procedure 

 

In this experimental program, the test layout adopted for evaluating the bond between GFRP and SFRSCC 

is similar to that proposed by RILEM [31]. The specimen comprises two SFRSCC blocks measuring 350 

mm in length and a transversal section (measuring 75 x 150 mm) connected by a steel hinge at the top 

zone and a Ø5 mm GFRP bar as flexural reinforcement at the bottom part. Two different series of concrete 

cover thickness, 15 and 25 mm, with different anchorage length (𝐿𝑏) ,90 mm, 140 mm and 200 mm 

were examined to evaluate their influence on the bond behaviour. The anchorage length of the GFRP bars 

was only changed in on side of the specimen, on the other side the bar was embedded almost in the 

entire length. Figure 15 and Figure 16 shows the process of specimen’s production and the detail of the 

specimen moments before the pullout test, respectively. 

 

 

 

(a) (b) 

Figure 15 – Specimen’s production: a) mould, b) appearance of specimens after cast. 
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Figure 16 – Detail of the specimen before pullout test. 

 

Specimens were identified by assuming labels shown in the first column of Table 3. The first set of 

symbols of the labels denoted as C15 (15 mm) or C25 (25 mm) represents the concrete cover thickness, 

and the second set of symbols refers to the anchorage length. For example, the label C15LB140 

corresponds to the specimen with a concrete cover thickness of 15 mm (C15) and anchorage length of 

140 mm (LB140). 

 

Table 3 – Specimen families’ detail. 

Families  Specimen’s 
quantities [un] 

Anchorage 
Length [mm] 

C15LB90  90 (Lb90) 

C15LB140  140 (Lb140) 

C15LB200  200 (Lb200) 

C25LB90  90 (Lb90) 

C25LB140  140 (Lb140) 

C25LB200  200 (Lb200) 
 

 

Figure 17 depicts the experimental test setup configuration used to evaluate the bond behaviour between 

GFRP and surrounding SFRSCC. Two linear transducers (LVDT) were used to measure the displacements 

and the slip at the loaded and free ends of GFRP bars. LVDT1 is used to control the slip at the loaded 

end, while LVDT2 is adopted to control the slip at the free end, both with a displacement range of ±5 mm 

and precision of 25 µm. Also, a strain gauge with a length of 5 mm was installed to the cross section of 

the bar to record the strains in the bar during the test. Pullout bending tests directly correlate the pullout 
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force applied to the GFRP bar and the corresponding values of loaded end slip (using the records from 

LVDT1 and subtracting the elastic deformation of the GFRP between the section of the GFRP bar where 

LVDT1 is mounted and the loaded end section) and free end slip (using the records from LVDT2) [32]. 

At the loaded end, a PVC tube with 50 mm length was placed surrounding the GFRP bar to prevent the 

bond between concrete and the bar and, consequently, avoid premature fracture of the SFRSCC in these 

zones. 

The specimens were subjected to bending on an EMM-04 machine. A load was applied using a load cell 

with a maximum load carrying capacity of 50 kN and the tests was displacement controlled at a speed of 

5 µm/s. The pullout force was calculated by the strain recorded in the stain gauge and considering the 

measured cross section area of the bar. 

Figure 17 – Pullout bending test setup details. 

 

For all specimens, the pullout force was observed and registered. The discussion of the results is 

presented in the next section. 

 

3.2. Test results and discussion 

 

The test results include the bond stress-slip relationship obtained for the series of the evaluated 

specimens. It was determined the average bond stress (𝜏 𝑚), as the pullout load divided by the bonded 



 P a g e  | 32 

 

UNIVERSITY OF MINHO  Diogo Lourenço Fernandes 

area, therefore assumed constant along the anchorage length (𝐿𝑏), and for each load it was recorded 

the loaded and free end slip, (𝑆𝑙𝑝) and (𝑆𝑓𝑝) respectively. 

The maximum average pullout force (𝐹𝑚𝑎𝑥), the corresponding loaded end slip (𝑆𝑙𝑝) and average bond 

strength (𝜏 𝑚𝑎𝑥) for each specimen family is presented in Table 4. It is noted that, as expected, the 𝜏 𝑚𝑎𝑥 

has decreased with the increase of bond length. The pullout force and bond strength of the GFRP bar 

were calculated by Eq. (21) and (22), respectively. 

 

𝐹𝑚𝑎𝑥 =
𝐹𝑎

2 ∗ (ℎ𝑙 − ℎ𝑗)
 

(21) 

 

where, 𝐹𝑎 (kN) is the vertical force induced by the servo actuator, ℎ𝑙 (mm) is the height from the 

centre of the steel hinge to the lower limit of the specimen and ℎ𝑗 (mm) refers to the heigh from the 

centre of the GFRP bar to the limit of the specimen. 

 

𝜏𝑚̅𝑎𝑥 =
𝐹̅𝑚𝑎𝑥

ᴨ ∗ Ø ∗ Lb
 

(22) 

 

where, 𝐹̅𝑚𝑎𝑥 (kN) is the maximum average applied pullout force, Ø is the diameter of the GFRP bar (mm) 

and 𝐿𝑏 is the anchorage length (mm). 

 

Table 4 – Average maximum pullout force, corresponding loaded end slip and bond strength. 

 C15LB90 C15LB140 C15LB200 C25LB90 C25LB140 C25LB200 

𝐹̅𝑚𝑎𝑥  (kN) 16.00 16.70 16.00 14.90 15.30 16.00 

𝑆𝑙𝑝 (mm) 1.71 1.71 1.90 2.23 2.22 2.00 

𝜏𝑚̅𝑎𝑥   (MPa) 11.32 7.59 5.09 10.54 6.96 5.09 
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Figure 18 show the relationships between the pullout force and slip at loaded and free ends for all 

specimens. 

 

  

(a) (b) 

Figure 18 – Relationships between the applied pullout force and slip at: a) Loaded end, b) Free end. 

 

Pullout force versus loaded end slip response is characterized by a short linear branch, followed by a 

nonlinear response up to peak due to the increase of damage, well represented in previous figures. The 

peak load occurred for a loaded end slip in a range of 1.7 mm and 2.2 mm. It is noted that in C25LB90 

and C25LB200 series the decrease of the pullout force with the increase of the slip is much smaller, a 

residual pullout force due to the friction of resistance between the GFRP and SFRSCC is shown. 

In C15LB90 series, the GFRP bars did not fail, but there was the greatest slip compared to all other 

series, as shown in Figure 19a. In contrary to what happened to the C15LB90 specimen, Figure 19b 

depicts a GFRP rupture in C25LB140, which is repeated in all other specimen except in C15LB90 and 

C25LB90. 
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(a) (b) 

Figure 19 – Detail of the specimens after the pullout test: a) C15LB90, b) C25LB140. 

 

The bond performance of GFRP bars embedded in SFRSCC was assessed by investigating the influence 

of anchorage length (𝐿𝑏) and concrete cover thickness. From the obtained results it is possible to 

conclude that pullout force increased with the increase of the anchorage length in all series, however in 

the C15 series this linearity wasn’t perfect, probably some experimental error has occurred. As expected, 

the values of the average bond stress (𝜏̅𝑚𝑎𝑥) decreased with the increase of anchorage length, also in 

all series. According to the relationship between different anchorage lengths, the smallest anchorage 

should be around 90 mm, this conclusion is based on the fact that the maximum average bonding stress 

reached the highest values until the slip, showing that in some specimens of this series the GFRP bar 

failure occurs. The maximum pullout force values were achieved when the anchorage length is twenty-

eight times its diameter (140 mm). 

Presented results and information of the experimental program showed no relationship between the 

applied force to the GFRP bar and the two concrete cover thickness analysed (15 mm and 25 mm). 
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Chapter 4 

4. Modelling the Bond Behaviour Between GFRP Bars and SFRSCC 

 

In the previous chapter it was presented the bond behaviour of GFRP bars embedded in SFRSCC. The 

main objective of this section is to calibrate the parameters of the local bond-slip relationship using the 

experimental results of pullout tests assessed previously. The parameters of the bond-slip relationship 

were determined, so that results of pullout tests could be particularly predicted in terms of applied pullout 

force versus slip at the loaded end of the specimens. 

For this purpose, analytical modelling was conducted using the FBL software that solves the differential 

equations that govern the bond behaviour along the bond length of the reinforcing bar (GFRP in this case) 

and determines the pullout force (𝐹) and the respective slip (𝛿) at loaded or free ends [33]. The 

analytical model developed in this section calibrated the 𝐹 − 𝛿 curves at the loaded end of each series. 

The parameters of local bond-slip law for each experimentally tested specimen series were determined 

from inverse analysis using this software and the proposed method. 

Apart from the analytical modelling, the bond tests were simulated numerically by using FEMIX computer 

program, which is based on the finite element method (FEM). To simulate the bond between GFRP bar 

and SFRSCC, an interface finite element with a non-linear constitutive law was used, whose constitutive 

law was defined from the FBL inverse analysis. The finite element model was calibrated so that the non-

linear interface finite element presented an acceptable capability to predict the bond behaviour between 

GFRP and SFRSCC in the context of bending behaviour.  

Both the analytical and numerical approaches were compared and validated with the experimental results 

presented in Chapter 3. 

 

4.1. Local bond stress-slip relationship 

 

The bond of the reinforcement in concrete is intrinsically a three-dimensional problem. As a result of its 

complexity, the bond behaviour is typically analysed as a uniaxial problem, and the local bond stress-slip 

relationship (𝜏 − 𝛿) between the reinforcement and the concrete must be determined in order to solve 



 P a g e  | 36 

 

UNIVERSITY OF MINHO  Diogo Lourenço Fernandes 

the differential equation governing that behaviour [8]. Based on the experimental results of pullout force 

versus slip from the experimental program presented in the previous chapter, the developed model was 

calibrated, and the constitutive bond-slip laws were attained. 

An interface finite element with a non-linear constitutive law was used to simulate the bond between the 

GFRP bar and the SFRSCC. The bond-slip relationship that defines the sliding behaviour of such interface 

elements is illustrated in Figure 20. 

 

 

 

 

 

 

 

Figure 20 – General bond-slip law  

 

Equation (23) characterizes the non-linear behaviour of the interface element: 

 

𝜏(𝑠) =

{
  
 

  
 (

𝜏0
𝑆0
) 𝑆                                   𝑆 < 𝑆0

(
𝑆

𝑆𝑚
)
𝛼

𝜏𝑚                  𝑆0 ≤ 𝑆 < 𝑆𝑚

(
𝑆

𝑆𝑚
)
𝛽

𝜏𝑚                            𝑆 ≥ 𝑆𝑚

 

(23) 

 

where 𝜏0 and 𝑆0 are, respectively, the bond stress and the slip at the end of the first branch, 𝜏𝑚 defines 

the bond strength and 𝑆𝑚 the corresponding slip. Parameter 𝛼 defines the shape of the pre-peak branch 

(bond behaviour up to peak stress) and 𝛽 defines the post-peak branch (bond behaviour in descending 

branch). 
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The values for 𝛼 range between 0 and 1. For 𝛼 = 1 a pre-peak linear branch is assumed, while for 𝛼 =

0 a constant bond stress of 𝜏𝑚 is considered in the interval 𝑆0 ≤ 𝑆 < 𝑆𝑚. The decay of bond stress 

transference is simulated by increasing the value of 𝛽 from 0 to infinity. The bond stress equal to the 

bond strength is assumed for 𝑆 ≥ 𝑆𝑚 when 𝛽 = 0 [32]. 

 

Figure 21 shows how parameters 𝛼 and 𝛽 influence the shape of the pre-peak and post-peak nonlinear 

branches, here represented as 𝛼1 and 𝛼2, respectively. 

 

  

(a) (b) 

Figure 21 – Illustration of the influence of the value of parameters 𝛼 and 𝛽 (represented as 𝛼1 and 𝛼2, respectively) in the 

shape of the bond-slip relationship: a) pre-peak phase, b) post-peak phase. 

 

4.1.1. Analytical study of bond-slip relationships determined from inverse analysis 

using the FBL software 
 

As mentioned before, an inverse analysis using FBL software was carried out to determine the local bond-

slip law for GFRP bars embedded into SFRSCC for each experimentally tested series. The FBL software 

solves the differential equations that governs the bond behaviour along the bond length of the GFRP bar 

and determines the pullout force (𝐹), the respective slip (𝛿) at loaded or free ends and the parameters 

of local-bond slip laws that fit the differential equations as accurately as possible. 
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The local bond-slip laws available on FBL are the NLML101, NLML102 and NLML103 which define 

different bond slip-stress relationship. The non-linear material law 101 is defined only by parameters 𝑆𝑚 

(slip corresponding to bond strength), 𝜏𝑚 (bond strength) and factors 𝛼 and 𝛽 (shape of pre-peak and 

post peak branch), Figure 22a. The NLML102 is described by four points where the slip and bond strength 

parameters are defined (𝑆1, 𝜏1; 𝑆2, 𝜏2; 𝑆𝑚, 𝜏𝑚; 𝑆4, 𝜏4),Figure 22b. The NLML103 was the law used in 

the inverse analysis in FBL and is defined by parameters 𝑆0, 𝜏𝑚, 𝑆𝑚, 𝛼 and 𝛽, described on the previous 

section and illustrated in Figure 20.  

 

 
 

(a) (b) 

Figure 22 – Different local bond-laws: a) transformation from NLML102 to NLML101, b) NLML102. 

 

The second-order differential equation that governs the slip of GFRP bonded into concrete is derived as 

follows:  

 

𝑑2𝛿(𝑥)

𝑑𝑥2
− 𝐽𝜏(𝛿(𝑥)) = 0 

(24) 

 

where J is the ratio between the perimeter(𝜋𝑑𝑓) and the axial stiffness (𝐸𝑓𝐴𝑓) of the reinforcing bar, 

being 𝑑𝑓, 𝐸𝑓 and 𝐴𝑓, respectively, the diameter, the longitudinal modulus of elasticity and the cross-

sectional area of the bar. 𝛿(𝑥) represents the slip between GFRP and the surrounding concrete at a 

section 𝑥 from the free end of the specimen. 
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Assuming that the GFRP has a linear elastic behaviour, based on Hook’s law, Eq.(25) can be deduced: 

 

𝜎𝑓(𝑥) = 𝐸𝑓
𝑑𝛿(𝑥)

𝑑𝑥
 

(25) 

 

where 𝜎𝑓 is the axial tensile stress of the GFRP bar. 

 

The distribution of bond shear stress 𝜏(𝑥) along the bond length is given by Eq.(26), based on Eq.(25). 

 

𝜏(𝑥) =
1

𝐽

𝑑2𝛿(𝑥)

𝑑𝑥
2  

(26) 

 

Using the experimental results obtained in Chapter 3, the main purpose of FBL is to obtain the parameters 

𝑆0, 𝜏𝑚, 𝑆𝑚, 𝛼 and 𝛽 of equation (23), that fit the differential equation (25) with as much accuracy as 

possible. 

 

FBL software is based on the theoretical condition of pullout force for Finite Bond Length. The debonding 

process for embedded bars (GFRP for example) into concrete can be analysed by solving the equation 

(24) imposing appropriate boundary conditions for a slip at the extremity of the bond transfer length 

(𝐿𝑡𝑟), which cannot exceed the available finite bond length (𝐿𝑓), [6]. The main steps of the algorithm 

used in the FBL software to determine the 𝐹 − 𝛿 curves at the loaded end and the local bond-law of each 

series are stated bellow, based on [8]: 

• In the first step is necessary to impose values for the parameters 𝑆0, 𝜏𝑚, 𝑆𝑚, 𝛼 and 𝛽 defining 

the bond-slip (𝜏 − 𝛿) relationship in the equation (23). The process to determine the error, e, 

defined as the area between the experimental and numerical curves is initialized. 

• When the free end slip is onset, the loaded end slip is calculated. 
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• For the experimental i-th scan reading, the free end slip, the loaded end slip and the pullout force 

are read. 

• Taking the free end slip and solving Eq.(24), the numerical pullout force at the loaded end is 

calculated. 

• The error, e, associated with the pullout force at the loaded end is calculated. This error is 

characterized as 
|𝐴 𝐹−𝛿

𝑚𝑜𝑑𝑒𝑙−𝐴 𝐹−𝛿
𝑒𝑥𝑝|

𝐴 𝐹−𝛿
𝑒𝑥𝑝 ∗ 100, where 𝐴 𝐹−𝛿

𝑚𝑜𝑑𝑒𝑙 is the area of the obtained 

theoretical 𝐹 − 𝛿 curves and 𝐴 𝐹−𝛿
𝑒𝑥𝑝 is the area under the average 𝐹 − 𝛿 of the experimental 

curves. 

• The process is updated until finding the minimum error. 

 

The tolerance introduced in the analysis is smaller than 1% which means that the validation of the bond-

slip parameters is conditioned by the restriction of ensuring similar values for the numerical and 

experimental peak pullout force and its corresponding slip. The independent parameters are searched 

exhaustively based on a predefined range and a predefined step. 

The FBL interface relative to the analysis carried out to C15LB90 series is illustrated in Figure 23. This 

figure shows that FLB presents the main imputed properties of the materials and the parameters used in 

the inverse analysis that define the bond-slip relationship, the graphically 𝐹 − 𝛿 response of the analysis, 

the error, e, and also the determined local bond slip law. One more useful feature of this software is the 

available “Plot” interface that clearly displays the local bond law for the evaluated series. This interface 

represents the curves obtained by the imputed values in the bond slip-stress relationship. 
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Figure 23 – FBL interface for the analysis of C15LB90 series. 

 

To carry out the analytical study in FBL, firstly is necessary to introduce the data relating to the local bond 

law and the fibre properties of the series that will be studied, see Figure 24a. FBL reads the data file 

where the parameters were introduced and then displays those parameters on his interface, Figure 24b. 

When the parameters are directly modified in FBL, the data file is updated. 

 

  

(a) (b) 
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Figure 24 – Data of the main parameters used in the inverse analysis for C15LB90 series: a) Data file, b) FBL interface. 

 

It is important to note that the results determined from the experimental program relative to the evaluated 

specimen series must be introduced into the software for comparison with the numerical results, as 

shown in Figure 25. The software cannot run without this data. 

 

 

Figure 25 – Introduction of the experimental results of 𝐹 − 𝛿 in the inverse analysis for C15LB90 series. 

 

The final step for the inverse analysis in FBL is to run the analysis considering that the introduced 

parameters of the Bond-slip relationship will generate 𝐹 − 𝛿 curves at the loaded or free ends of the 

specimen’s series and the respective local bond-slip law. With the visualization of those curves the values 

of the imputed parameters need to be adjusted in order to fit the numerical curves (illustrated in green) 

with the experimental curves (illustrated in red). 

Figure 26 shows the comparison between numerical and experimental results in the context of pullout 

force-slip at the loaded end for C15LB90 series displayed in the FBL software window after running the 

analysis. It is possible to directly analyse the above-mentioned comparison, the error, e, and the 

determined local bond slip law. For the visualization of the local bond law of the evaluated series in FBL 

the user must press “Plot”, see Figure 27.  
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Note that Figure 26 presents both numerical (NUM) and experimental (EXP) results in relation to 𝐹 − 𝛿 

at the loaded end. 

 

Figure 26 – Calibration between theoretical and experimental 𝐹 − 𝛿 curves for C15LB90 series in FBL. 

 

 

 

 

 

 

 

 

 

Figure 27 – Local Bond Law for C15LB90 series determined by inverse analysis. 
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The same inverse analysis strategy was conducted for all series of the experimental programme. Figure 

28 show the comparison between numerical and experimental results of pullout force versus loaded end 

slip. 

 

  

(a) (b) 

  

(c) (d) 

  

(e) (f) 

Figure 28 – Calibration between theoretical and experimental 𝐹 − 𝛿 curves for series: a) C15LB90, b) C25LB90, c) 

C15LB140, d) C25LB140, e) C15LB200, f) C25LB200. 

 

Through the analysis of the graphs presented in Figure 28 it is evident that the proposed method is 

capable of simulating with good accuracy the pullout force versus loaded end slip for all specimen series 

tested. Only the slip corresponding to the maximum bond stress of C25LB90 series is higher comparing 

to the 𝑆𝑚 obtained experimentally. 

The respective bond-law of each series captured from FBL is depicted in Figure 29. 
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(a) (b) 

  

(c) (d) 

  

(e) (f) 

Figure 29 – Local bond law for series: a) C15LB90, b) C25LB90, c) C15LB140, d) C25LB140, e) C15LB200, f) C25LB200. 

 

The curves representing the stress-slip relationship are presented in 3 different colour, light blue, red and 

dark blue. The parameters defining the bond stress-slip relationship were imposed using FBL in a range 

of values from minimum to maximum with an increment so that the local-bond law could be determined. 

The light blue and dark blue curves represent the minimum and maximum parameter values set in the 

software, and the red curve represents the bond-slip law determined between those values. Figure 24 

presented previously shows the range of parameters values imposed in FBL for C15LB90 series, which 

lead to the respective local-bond law curves in Figure 29. 
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In the above presented curves, the bond strength for each series is represented with a number that relates 

to the best numerical law obtained from the exhaustive search that best fits the numerical and 

experimental envelop of pullout force vs slip at loaded end (minimum error, e). 

Table 5 shows the parameters determined from the inverse analysis for each series in relation to the 

bond-slip law and the error obtained in each exhaustive search. 

 

Table 5 – Parameters of the bond model obtained from the inverse analysis in FBL 

 

From Table 5 can be pointed that the error in each series is acceptable, only in C25LB140 series the 

error is higher than desired because the decay of bond stress transference in the post-peak phase was 

accentuated and the calibration of parameter 𝛽 was difficult to achieve.  

As expected, the peak bond stress 𝜏𝑚 decreased with the increase of anchorage length 𝐿𝑏, the slip at 

bond strength decreased with the increase of anchorage length and the different concrete cover 

thicknesses does not influence the maximum bond shear stress. 

 

4.1.2 Numerical simulation of the pullout bending tests and predictive 

performance of the proposed bond model 

 

The main goal of this section was to simulate numerically the pullout bending tests of the experimental 

program described in Chapter 3 and calibrate the FEM model based on the average experimental pullout 

load-slip curves. Similar to the previous section the parameters of the defined local bond-slip relationships 

were determined by inverse analysis. Also, the predictive performance of the proposed method is 

assessed. 

Bar diameter Concrete  cover Anchorage length  error
(mm) (mm) (mm) (Mpa) (mm) (mm) (%)

C15LB90 15 90 11,4 1 2,5 0,6 2,4 5,9

C15LB140 15 140 8,3 0,4 2,3 1,4 1,8 12,7

C15LB200 15 200 5,6 0,2 2,3 1,5 2 12,7

C25LB90 25 90 10,9 1,7 3,5 0,7 2 7,4

C25LB140 25 140 8,4 1,2 1 1 1,8 20,6

C25LB200 25 200 5,3 0,1 4 1,5 2 9,3

Series

Results of Bond Law from FBL

 

Series configuration 

5
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The first step to simulate numerically the pullout bending test was the creation of a finite element mesh 

adapted to the geometry of the specimen analysed in the experimental program. Only one block (the one 

with variable bond length) was considered in the FE model, due to the test setup symmetry. 

The SFRSCC block was modelled using 4-node plain stress finite elements, Figure 30a, with a Gauss-

Legendre integration scheme of 2x2. The steel hinge was modelled using 4-node plain stress finite 

elements, Figure 30a with 2x2 Gauss-Legendre integration scheme. To simulate the GFRP bar embedded 

in the concrete a linear elastic stress-strain relationship was assumed and the reinforcement was 

discretized by 2 node Frame 2D elements, Figure 30b. The interface finite elements used to simulate the 

bond behaviour between GFRP bars and surrounding SFRSCC were modelled by 4-nodes-2D-interface 

elements (two from the GFRP bar and two from the surrounding concrete) with 2 Gauss-Legendre 

integration points, as shown in Figure 30c. 

 

   

(a) (b) (c) 

Figure 30 – Types of finite elements used in the FEM model: a) Lagrangian 4-node elements, b) Linear 2-node elements, c) 

Linear 4-node elements [8]. 

 

A tri-linear tensile-softening diagram was used to simulate the nonlinear material behaviour of SFRSCC in 

FEMIX, see Figure 31. This behaviour is implemented in FEMIX as NLMM_104 constitutive model. The 

values of the parameters of the constitutive model for SFRSCC are summarized in Table 6. 
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Figure 31 – Trilinear stress-strain diagram to simulate the fracture mode I crack propagation [34]. 

 

Table 6 – Values of the parameters of SFRSCC constitutive model used in pullout bending test simulation. 

 

 

Regarding the Glass Fibre Reinforced Polymer, the linear elastic stress-strain relationship assumed in the 

FEM model is presented in Figure 32 and the material properties are summarized in Table 7. 

 

Square root of the area of the finite elementCrack bandwidth 

Threshold angle 

p=2

Poisson's ratio

Young's modulus 

Compressive strength

Average tensile strength

Trilinear stress-strain diagram

Maximum number of cracks per 

integration point

Parameter Values (SFRSCC)

ν= 0,2

𝐸𝑓 = 27000 𝑀𝑃𝑎

𝑓𝑐 = 50 𝑀𝑃𝑎

𝑓𝑐𝑡𝑚 = 2,9 𝑀𝑃𝑎

𝐺𝑓
 = 4,187 𝑁 𝑚𝑚

𝜉1 = 0,09

𝜉2 = 0,393

𝛼1 = 1,293

𝛼2 = 0,579

𝛼𝑡 = 30°

𝛼1 = 𝜎𝑛,2
𝑐𝑟  𝜎𝑛,1

𝑐𝑟 𝛼2 = 𝜎𝑛,3
𝑐𝑟  𝜎𝑛,1

𝑐𝑟 𝜉1 = 𝜉𝑛,2
𝑐𝑟  𝜉𝑛,𝑢

𝑐𝑟 𝜉2 = 𝜉𝑛,3
𝑐𝑟  𝜉𝑛,𝑢

𝑐𝑟𝜎𝑛,1
𝑐𝑟 = 𝑓𝑐𝑡
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Figure 32 – Linear material behaviour of GFRP bars. 

 

Table 7 – Values of GFRP material properties. 

 

 

The interface finite elements were numerically simulated with the NLMM301 constitutive model. This 

numerical model defines the bond-slip laws for each evaluated series in the pullout tests. The properties 

of this constitutive model are similar to those of the analytical model (NLML103) used in the previous 

section, see Figure 20. Since a 2D simulation was performed in this study, the interface was applied with 

a constant thickness equal to the perimeter of the GFRP bar. 

In the finite element mesh was placed a pinned support (restrained in x and y) 50 mm from the left side 

of the block and two roller supports (restrained in x and z) in the symmetry axle of the block. Figure 33 

shows the finite element mesh employed to simulate the behaviour between GFRP and SFRSCC in relation 

to pullout force versus slip at loaded end. 

An incremental loading procedure with the arc length technique was used to improve the performance of 

the numerical simulation and avoid the instability in the convergence of the incremental/iterative process. 

For that, one-point vertical load was placed 50 mm from the symmetry axle of the specimen. 

Poisson's ratio (ν)

Ultimate tensile 

strength 

45000 0,15 945,56

Mass per unit 

volume (γ)

22,3

Young's modulus

(𝑘𝑁 𝑚3)

(𝐸𝑓)

(𝑀𝑃𝑎)
(𝜎𝑓𝑢)

(𝑀𝑃𝑎)
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All the geometric and mechanical parameters presented were determined from the experimental program 

carried out on materials employed in the pullout bending tests reported in Chapter 3. 

 

 

Figure 33 – Finite element model assembled to simulate pullout bending tests. 

 

After creating the finite element mesh the parameters of bond-slip law for each numerical simulation were 

determined. Those values were found by applying the parameters of the bond-slip law obtained in section 

4.1.1 and then performing the exhaustive search that leaded to the best fit of the numerical curves with 

the experimental envelop in terms of pullout force and the corresponding slip at the loaded end section 

of the tested specimen 

The Newton-Raphson method was used to solve the nonlinear system of equations with an 

incremental/iterative procedure of displacement control with the arc-length technique. This iterative 

process uses a constant load increment (∆𝐹) and a predefined displacement increment (∆𝑎) up to a 

certain combination is reached, leading to the solution of the numerical simulation.  

Figure 34 exhibits the bond-slip relationships between numerical and experimental results determined 

from FEMIX inverse analysis for each series. 
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(a) (b) 

  

(c) (d) 

  

(e) (f) 

Figure 34 – Bond-slip relationships calibrated using FEMIX for series: a) C15LB90, b) C25LB90, c) C15LB140, d) 

C25LB140, e) C15LB200, f) C25LB200. 

 

From the analysis of Figure 34 is evident that the FE model predicts fairly in an acceptable way the 

experimental 𝐹 − 𝛿 curves at loaded end registered numerically, especially the solutions in the pre-peak 

linear branch. 

Table 8 shows the calibrated parameters of bond law for pullout bending tests determined in FEMIX 

inverse analysis. 
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Table 8 – Parameters of the bond model obtained from the inverse analysis in FEMIX. 

 

 

As concluded in the experimental program and the previous section, the numerical analysis shows that 

different SFRSCC cover thickness (15 mm or 25 mm) does not influence the maximum bond shear stress 

in the tested series. 

The parameter 𝑆0 represents the slip corresponding to the end of the linear phase of the local bond 

relationship and is only a small component of all the pullout force-slip relationship. Table 5 shows some 

variation in the values of 𝑆0, but in Table 8 the values for this parameter are almost unaffected by the 

two variable properties considered in this study (SFRSCC cover thickness and anchorage length). 

As expected, the peak bond stress 𝜏𝑚 decreased with the increase of anchorage length 𝐿𝑏, which was a 

consequence of the nonlinear distribution of the bond stress along 𝐿𝑏 [6].  

The maximum slip 𝑆𝑚 corresponding to the bond strength defines the limit between the hardening and 

the softening phases of the bond-slip law which significantly influences the bond-slip relationship. In the 

inverse analysis where FBL was used, 𝑆𝑚 values were smaller for series with bigger GFRP anchorage 

length and higher for series with a bigger concrete cover. The same conclusion on 𝑆𝑚 the parameter was 

confirmed in the inverse analysis using the finite element model. 

Parameter 𝛼 defines the shape of the pre-peak branch and according to the above presented results the 

value was around 1 (pre-peak linear branch). 

The values of 𝛽 controlled the bond behaviour in the descending branch and ranged from 1 to 3.9 

depending on the decay of bond stress transference. 

Both the analytical and numerical methods predicted the experimental results quite accurately. 

 

Bar diameter Concrete  cover Anchorage length  
(mm) (mm) (mm) (Mpa) (mm) (mm)

C15LB90 15 90 15,5 2,2 1 0,6 2

C15LB140 15 140 12,4 2 1 1 2,7

C15LB200 15 200 9,4 2,4 0,5 1 3,9

C25LB90 25 90 15,1 2,7 0,5 0,7 1

C25LB140 25 140 12,3 2,3 0,5 1 3

C25LB200 25 200 10 2,4 0,5 1 2,5

5

Results of Bond Law from FEMIXSeries configuration 

Series
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Chapter 5 

5. Numerical Modelling of Shallow beams 

 

The present chapter is dedicated to the numerical modelling of shallow beams based on previous 

experimental work carried out by Fonseca, [35], which investigated the bending and shear behaviour of 

laminar structures in high-performance steel fibre reinforced concrete (HPSFRC). The main objective of 

the numerical modelling was to determine the constitutive model of the intervening materials in the tests 

(concrete, steel and Glass fibre reinforced polymer (GFRP)) in order to assure accurate numerical 

simulations of the bending tests. 

The importance of assessing the numerical model in this section is by means essential for further use 

throughout this dissertation, especially in the numerical modelling of I beams in next chapter, where the 

same constitutive laws of the materials determined in this chapter were adopted. 

The chapter begins with the presentation of the experimental program described in the reference work, 

[35], as well as an analysis of the main results. The constitutive model of the intervening materials is then 

described, and the methodology that leads to the validation of the numerical simulations is presented.  

Additionally to the numerical simulations related to the experimental tests, another two simulations using 

glass fibre reinforced polymer (GFRP) and post-tension steel wires were carried out for comparing different 

reinforcement solutions. 

Is important to point out that for the numerical modelling and the Finite Element analysis the software 

GID and FEMIX were used, respectively. 

 

5.1. Experimental program  
 

Fonseca [35] performed a series of tests to assess the steel fibre reinforcement effectiveness for shallow 

structural elements failing in bending and shear. In this section only the behaviour of reinforced concrete 

elements failing in bending is presented and studied. 
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The experimental program consisted of carrying out a four-point notched beam bending test (4PNBBT) 

on three series of slab strips. Each one had a shear span equal to 450 mm, a total length of 1600 mm, 

a distance between supports of 1350 mm and a cross-section of 350 x 150 mm, see Figure 35. Each 

series of shallow beams were reinforced differently, the series with the designation A were reinforced 

longitudinally with 3Φ6 (ρ=0.2), series with the designation B with 3Φ8 (ρ=0.36) and series C with 

3Φ10 (ρ=0.56). In the top part of the cross-section of all tested slab strips, three steel bars of 6 mm 

diameter were used. Twelve slabs were tested for comparison purposes regarding the effectiveness of 

steel fibre reinforcement: six reinforced with steel fibres and the other six without steel fibres. 

 

 

Figure 35 – Geometry, support and load conditions of the tested shallow beams including the monitoring system [35]. 

 

The mix composition used to manufacture the SFRSCC included 45 𝑘𝑔 𝑚3  of hooked-end steel fibres. 

The materials used in the mix composition were cement (C) labelled as CEM I 52.5 R (rapid hardening 

and high strength cement, according to EN197-1:2000), limestone filler MICRO 100 AB (LF), a 

superplasticizer (SP) with the trade name SIKA 3002 HE, water (W), four types of aggregates (fine and 

coarse river sand, FS and CS; crushed calcareous of 6 to 14 mm size, CG_1; crushed calcareous of 14 

to 20 mm, CG_2), and hooked ends steel fibres (SF) with a length (𝑙𝑓) of 60 mm, a diameter (∅𝑓) of 

0.75 mm, aspect ratio (𝑙𝑓 ∅𝑓) of 80 and yield stress of 1100 MPa, see Table 9. 

For the slab strips reinforced with conventional steel bars, the self-compacting concrete mix (SCC) was 

similar to the mix composition used for the SFRC slab strips except that the former ones did not include 

fibres. The SCC mix composition is also presented in Table 9. 

Both concrete compositions showed good homogeneity and cohesion, no sign of segregation was 

detected, and the self-compacting requirements were assured. The total spread (𝑑𝑓), the time to reach 
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a spread diameter of 500 mm (𝑇50), and the blocking ratio parameter (𝐻2 𝐻1) of the L Box test (EFNARC 

2002) were measured, see Table 9. 

 

Table 9 – Composition of SFRSCC and SCC used on slab strips (per 𝑚3 of concrete). 

Composition SCC  SFRSCC  

Cement (CEM I 52.5 R) (𝑘𝑔)   
Water (𝑑𝑚3)   

Limestone filler (MICRO 100 AB) (𝑘𝑔)   

Superplasticiser (SIKA 3002 HE) (𝑑𝑚3)   

Fine river sand (𝑘𝑔)   
Coarse river sand (𝑘𝑔)   

Crushed calcareous CG_1 (6 − 14 𝑚𝑚)   

Crushed calcareous CG_2 (14 − 20 𝑚𝑚)   

Hooked end steel fibres (𝑘𝑔)   
𝑑𝑓 (𝑚𝑚)   

𝑇50 (𝑠)   

𝐻2 𝐻1   

 

The slab strips were subjected to four-line loading points distributed in the width of the slab section, as 

shown in Figure 35, and the load was registered by a load cell of 300 kN maximum capacity, while the 

deflections were measured using five LVDT’s. The tests were performed with servo-controlled equipment, 

imposing a deflection ratio of 30 𝜇𝑚 𝑠 in the central LVDT for test control purposes. 

To differentiate and identify the tested slab strips the label “Li_j_k” was used. The first symbol of the 

label denoted as “L” represented the series that the slab strips pertain to and can be replaced by A, B or 

C. The second symbol “i” identified the number of the slab strip test in each series (note that two slab 

strips were tested per each series). The symbol “j” represented the diameter of the steel bars used as 

tensile longitudinal reinforcement and “k” identified the number of applied fibres in the concrete mix 

(value in 𝑘𝑔 𝑚3). 

For example, the label B1_8_45 corresponded to the first slab strip of “B” series reinforced with 8 mm 

diameter longitudinal steel bars and included 45 𝑘𝑔 of steel fibres per 𝑚3 of concrete. 

The relationship between the measured deflection at the midspan and the applied force of the tested slab 

strips is depicted in Figure 36. Each curve represents the average load values at each deflection level, 

obtained from the two shallow beams of the corresponding series (A, B or C). 
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(a) (b) 

 

(c) 

Figure 36 – Average force versus slip at midspan of series: (a) A_6, (b) B_8, (c) C_10 [35]. 

 

From the analysis of Load-central deflection curves of the tested slab strips was observed that the load 

carrying capacity of the SFRSCC slab strips was higher that the corresponding SCC ones. The difference 

of the load carrying capacity between slabs reinforced with fibres and without fibres increased from the 

crack initiation up to the maximum load of the SFRSCC slab, however, that difference decreased with the 

increase of the percentage of longitudinal reinforcement.  

Based on the analysis from the experimental study the contribution of the fibres for the slab load carrying 

capacity started from the very early stages of the slab deformation, shortly after the formation of incipient 

cracks and the resulting 𝐹 − 𝛿 curves showed that fibre reinforcement is highly effective for the design 

requirements imposed by the serviceability limit states, owing to its grater effectiveness the lower the 

percentage of longitudinal reinforcement (ρ). 
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5.2. Numerical simulations using FEMIX-GID software 
 

Through a numerical simulation of an experimental program, subsequent studies can be conducted, for 

example, the beam bending tests that determine the relationship between the applied force and the 

deflection at midspan. Thus, based on the experimental behaviour of a certain set of models, it is possible, 

in a faster and more economical way, to predict the behaviour of similar models by carrying out parametric 

studies that were not considered in the original experimental program. 

For each series of shallow beams tested in the experimental program carried out by [35], finite element 

simulations were performed. The performance of the numerical model was appraised by tunning the 

parameters that define the Mode I crack constitutive law of the concrete used in the tests (SFRSCC and 

SCC) and the constitutive model of the steel. 

In addition to the numerical simulation of all series of shallow beams using conventional steel 

reinforcement, another numerical simulation was performed by maintaining the same properties of the 

SFRSCC of the experimental program and reinforcing the slab with Glass fibre reinforced polymer (GFRP) 

defined Table 7 and two prestressing steel wires. This section also compares the results obtained by 

using this different approach to slab reinforcement with those obtained by conventional reinforcements, 

and a conclusion is drawn. 

Gid software is a pre and postprocessor computer program for numerical simulations commonly used in 

science and engineering. This software allows the creation of the geometry of the numerical model, mesh 

generation and visualization of the analysis. When using FEMIX and GID, the last one creates the data file 

with the extension _gl.dat if the structure attributes and their finite element mesh are introduced, and 

then reads the results obtained in the post-processing carried out by Posfemix (FEMIX is divided in three 

software’s: Prefemix, Femix and Posfemix), allowing the visualization of numerical results in a very 

straightforward and intuitive way. 

In Figure 35 is depicted the geometry, support and load conditions of the tested shallow beams used in 

the numerical simulation. Is important to mention that three steel bars of 6 mm diameter were used in 

the top part of the cross section of all tested beams. Based on the symmetry of the structure, only half of 

the beam was considered in the modelling. 

The numerical modelling started with the series flexural reinforced with 6 mm diameter longitudinal steel 

bars and without steel fibres in the self-compacting concrete (A_6_0). Firstly, was necessary to introduce 
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the data related to the shallow beams that define its geometry, such as the vertices of the beam and the 

intersection points between the faces of the beam and the longitudinal reinforcement. 

The concrete and steel surfaces were created after the main points of the beam geometry had been 

defined, see Figure 37. 

 

 

 

 

Figure 37 – Geometry of the beam used for the simulation of the A_6_0 series. 

 

A poorly defined geometry of the structure or the information about the intervening materials around it 

will cause issues when creating the numerical mesh and the future analysis. This first phase is probably 

the most important for the numerical modelling. 

 

After defining all the geometry of the beam and the layers that characterize each material, the next step 

was to create the finite element mesh with an intermediate level of refinement that thought to be 

acceptable based on a sensitivity analysis. From previous research is known that with an intermediate 

level of refinement of the mesh is achieved more effective results [36]. 

The concrete used in the beams was simulated by 8-node Serendipity plain stress finite elements with 

2x2 Gauss-Legendre integration scheme, Figure 38, and quadratic 3-node Embedded cable 2D with 2 

points Gauss-Legendre integration scheme was used to simulate the longitudinal reinforcements. Is 

important to note that the steel bars were assumed to be perfectly bonded and embedded into the 

surrounding concrete.  
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Figure 38 – Serendipity 8-node finite element [8]. 

 

The example of the created finite element mesh for shallow beams reinforced with 6 mm diameter 

longitudinal steel bars and without steel fibres in the self-compacting concrete (A_6_0) is depicted in 

Figure 39. After the creation of the mesh was necessary to introduce the information concerning the 

characteristics of the materials and the boundary conditions. 

 

 

Figure 39 – Finite element mesh used for the simulation of A_6_0 series (dimensions in mm). 

 

In this simulation was considered a roller support at the symmetry axle (restrained in x and z) of the beam 

and a pinned support (restrained in x and y) at 125 mm from the lateral side of the beam, as shown in 

Figure 40. Also, at 225 mm from the symmetry axle of the beam was placed a point load as indicated in 

the experimental test, Figure 41. 
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Figure 40 – Supports of the shallow beams. 

 

Figure 41 – Loads or prescribed displacements. 

 

It was also necessary to characterize the concrete and the reinforcement in the tests. To simulate the 

post-cracking behaviour of the concrete, a quadrilinear tensile-softening diagram available in the software 

was used and the Fracture Mode I parameters were defined. 

Table 10 presents the concrete properties used for the A_6_0 series numerical simulation. The 

constitutive model used for the simulation of the concrete behaviour was the NLMM104 which allowed 

enough flexibility to model the most significant aspects of the tension-softening effect. 

Is important to note that only the Quadrilinear tensile-softening diagram was used for the A_6_0 series 

numerical simulation. In this case, it was difficult to assess the concrete model parameters by fitting the 

force vs deflection numerical and experimental curves. For all other simulations the trilinear tensile-

softening diagram was used and the values of 𝑓𝑐𝑡, 𝜉1, 𝛼1, 𝜉2, 𝛼2 defined the fracture mode I properties.  
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Table 10 – Values of the parameters of the concrete constitutive model for L_6_0 series. 

 

 

 

 

 

 

 

 

 

 

The graphical difference between the trilinear and quadrilinear tensile-softening diagrams is depicted in 

Figure 42. 

 

  

(a) (b) 

Figure 42 – Tensile-Softening diagrams used in GID: (a) Trilinear, (b) Quadrilinear. 

 

The Concrete properties used in the numerical simulation of the B_8_0 and C_10_0 shallow beams 

series is presented in Table 11. 

Square root of the area of the finite element

Maximum number of cracks 

per integration point
p=2

Crack band-width 

Threshold angle 

Parameter Values (SCC)

Poisson's ratio ν=0,2

Young's modulus 

Compressive strength

Average tensile strength

Quadrilinear Tensile-

softening diagram

Parameter defining the mode 

I fracture energy available to 

the new crack

𝐸𝑓 = 37490,95 𝑀𝑃𝑎

𝑓𝑐 = 86,34 𝑀𝑃𝑎

𝑓𝑐𝑡𝑚 = 3,4 𝑀𝑃𝑎

𝐺𝑓
 = 0,05 𝑁 𝑚𝑚

𝜉1 = 0,025

𝜉2 = 0,5

𝛼1 = 0,3

𝛼2 = 0,3

𝛼𝑡 = 30°

𝜉3 = 0,6 𝛼3 = 0,3

 1 = 1
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Table 11 – Values of the parameters of the concrete constitutive model for B_8_0 and C_10_0 series. 

 

 

 

 

 

 

 

Table 12 shows the concrete properties used in the numerical simulation of the B_8_45 and C_10_45 

shallow beams series and Table 13 presents the values of the parameters used to define the constitutive 

model of conventional steel reinforcement. The constitutive model used for the simulation of the steel 

behaviour was the NLMM201, see Figure 43. 

 

Table 12 – Values of the parameters of the concrete constitutive model for B_8_45 and C_10_45 series. 

 

 

 

 

 

 

 

Square root of the area of the finite element

Parameter Values (SCC)

Poisson's ratio ν=0,2

Young's modulus 

Parameter defining the mode 

Crack band-width 

Threshold angle 

Compressive strength

Average tensile strength

Trilinear Tensile-softening 

diagram

Maximum number of cracks 

per integration point
p=2

𝐸𝑓 = 37490,95 𝑀𝑃𝑎

𝑓𝑐 = 86,34 𝑀𝑃𝑎

𝑓𝑐𝑡𝑚 = 3,4 𝑀𝑃𝑎

𝐺𝑓
 = 0,162 𝑁 𝑚𝑚

𝜉1 = 0,005

𝜉2 = 0,3

𝛼1 = 0,2

𝛼2 = 0,05

𝛼𝑡 = 30°

 1 = 1

Square root of the area of the finite element

Parameter Values (SFRSCC)

Poisson's ratio ν=0,2

Young's modulus 

Parameter defining the mode 

Crack band-width 

Threshold angle 

Compressive strength

Average tensile strength

Trilinear Tensile-softening 

diagram

Maximum number of cracks 

per integration point
p=2

𝐸𝑓 = 38184,5 𝑀𝑃𝑎

𝑓𝑐 = 91,22 𝑀𝑃𝑎

𝑓𝑐𝑡𝑚 = 3,44 𝑀𝑃𝑎

𝐺𝑓
 = 1,0 𝑁 𝑚𝑚

𝜉1 = 0,005

𝜉2 = 0,3

𝛼1 = 0,75

𝛼2 = 0,085

𝛼𝑡 = 30°

 1 = 1
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Table 13 – Values of the conventional steel constitutive model. 

 

 

 

 

 

 

 

 

 

Figure 43 – Steel properties used in the simulation of the A_6_0 slab strip series. 

 

The final step before performing the numerical simulation was the definition of the load cases and the 

combinations that better suited the experimental program. In all the numerical simulations the load was 

applied by direct displacement—control at the loaded point (Node number 653, degree of freedom Y) and 

the Newton-Raphson algorithm was used. 

After going through all the steps described previously, the calculation of the structure behaviour was 

conducted through FEMIX. More detailed information about the steps of modelling using the software 

GID can be found in the APPENDIX. 

The relationship between the applied force and the deflection at the mid-span obtained from the numerical 

simulations for all beam series are gathered in Figure 44, revealing that this model is validated and can 

assess, with enough accuracy, the behaviour of elements failing in bending. Furthermore, the proposed 

concrete and steel constitutive models are able to define the post-cracking behaviour of the tested beams. 

 

Young's modulus

200

Third branch 
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(𝑚𝑚) 𝜉𝑠𝑦 𝜎𝑠𝑦 𝑀𝑃𝑎 𝜉𝑠 𝜎𝑠 𝑀𝑃𝑎 𝜉𝑠𝑢 𝜎𝑠𝑢 𝑀𝑃𝑎 (𝐺𝑃𝑎)
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(a) 

  

(b) (c) 

  

(d) (e) 

Figure 44 – Load vs. Deflection at mid-span obtained experimentally and numerically (assuming perfect bond) for the 

shallow beams series: (a) A_6_0, (b) B_8_0, (c) B_8_45, (d) C_10_0, (e) C_10_45. 
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5.2.1. Influence of reinforcing shallow beams with GFRP and prestressed steel 

wires 

 

As mentioned before, the main aim of simulating the previous described shallow beams with different 

longitudinal reinforcement (GFRP and Prestressed steel wires) was to analyse the performance of this 

shallow beams failing in bending and compare the results of force vs deflection at mid-span of each 

simulation. 

The beams were identified as B_8_45 _Post Tensioning and C_10_45 _Post Tensioning and were 

simulated numerically by using the same concrete constitutive model adopted for the simulation of 

B_8_45 and C_10_45 series, respectively, and using the fracture mode I tunned parameters, presented 

in Table 12. The values used for simulating the conventional steel behaviour is presented in Table 13.  

In relation to the reinforcement in the FE mesh the prestressed steel wires and GFRP bars were simulated 

by 3-node Cable 2D elements with 2 Gauss-Legendre integration points. 

The properties of the constitutive model used for simulating the behaviour of GFRP bars in the present 

analysis were the same obtained from the experimental program presented in Chapter 3, Table 7 provides 

detailed information. 

In addition, for better comparison purposes the cross-section area of the GFRP bars (Φ5) was 

approximated equal to the cross-section area of the flexural conventional steel reinforcement used in 

B_8_45 (3Φ8) and C_10_45 (3Φ10) series for each numerical simulation, respectively.  

Regarding the prestressing purposes, two steel wires were used as flexural reinforcement of the beams 

along with the GFRP bars. The constitutive model used to simulate the behaviour of the steel wires is 

presented in Table 14. 

 

Table 14 – Values of the parameters of the steel wires constitutive model. 

 

 

1 195

Diameter Third branch 

exponent

Young's modulus

6 0,007991 1558,3 0,029 1664,15 0,05 1770

(𝑚𝑚)
𝜉𝑠𝑦 𝜎𝑠𝑦 𝑀𝑃𝑎 𝜉𝑠 𝜎𝑠 𝑀𝑃𝑎 𝜉𝑠𝑢 𝜎𝑠𝑢 𝑀𝑃𝑎 (𝐺𝑃𝑎)
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The prestress level of 75% of the steel wires yielding stress (𝑓𝑠𝑦 = 1558.3 𝑀𝑃𝑎) was adopted for the 

numerical simulation. Therefore, was necessary to estimate the correspondent temperature to the 

intended prestress. This logic is demonstrated by the following equations: 

 

𝜎 = 𝐸 ∗ 𝜀 (27) 

 

where E (MPa) is the Young’s modulus and 𝜀 is the tensile strain. 

 

The strain can also be written as: 

 

𝜀 =
∆𝐿

𝐿
=
𝛼 ∗ ∆𝑇𝑢 ∗ 𝐿

𝐿
 

(28) 

 

Thus, replacing the Eq.(28) in Eq.(27) comes: 

 

𝜎 = 𝐸 ∗ 𝛼 ∗ ∆𝑇𝑢 (29) 

 

The uniform thermal load correspondent to the intended prestress was -600ºC. This negative thermal 

load applied to the steel wires implemented an upward deflection to the beams, meaning that the 

reinforcement is being contracted. 

To better understand how the beams were simulated, Figure 45 and Figure 46 shows the GID graphic 

visualization of this elements and Figure 47 the respective beams cross section. 
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Figure 45 – GID graphic visualization of the assigned materials constitutive models in the B_8_45_Post Tensioning beam. 

 

 

Figure 46 – GID graphic visualization of the assigned materials constitutive models in the C_10_45_Post Tensioning beam. 

 

  

(a) (b) 

Figure 47 – Cross section of the numerically simulated beams: (a) B_8_45_Post Tensioning, (b) C_10_45_Post Tensioning. 

 

The results of the numerical simulations performed with the B_8_45_Post Tensioning and 

C_10_45_Post Tensioning shallow beams, assuming perfect bond at the GFRP, steel wires and 

Conventional Steel-concrete interface, in relation to the applied load and the deflection at the mid-span is 

depicted in Figure 48.  
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(a) (b) 

Figure 48 – Load vs. Deflection at mid-span obtained numerically (assuming perfect bond) for the beams: (a) B_8_45_Post 

Tensioning, (b) C_10_45_Post Tensioning. 

 

Figure 49 shows the comparison of the numerical relationship between the 𝐹 𝑣𝑠 𝛿 at mid-span of the 

numerically simulated beams presented in the previous section with this hybrid system. 

 

 

Figure 49 – Comparison between force deflection response of the developed numerical simulations. 
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The analysis of Figure 49 evidence that in the beams without steel fibres, after the peak, a constant or 

barely noticeable hardening phase follows, which is the typical behaviour of elements with only ordinary 

reinforcement since the failure mode depends on the steel. On the other hand, the beams reinforced 

with steel fibres show a softening phase after peak load because after the concrete cracks open, the 

ordinary reinforcement and steel fibres start working together with the steel fibres bridging the cracks. 

As a result, fibre reinforced beams show higher load carrying capacity and the energy dissipation 

decreases slowly. 

The application of the GFRP bars and the two prestressed steel wires in the slab strips provided 

significant increase in the load carrying capacity (ultimate flexural capacity) at serviceability limit state 

conditions and at steel yield initiation. Greater benefits would be achieved if the prestress level was 

applied both to the GFRP bars and the steel wires, increasing the shear capacity of the beams. 

This simple numerical strategy showed that the model was validated and the behaviour of shallow beams 

failing in bending was assessed. 
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Chapter 6 

6. Case Study of I-shaped cross-sectional beams for buildings 

 

This chapter explores the potentialities of a new generation of structural systems through a hypothetical 

case study. This study is based on the design and numerical simulation using FEMIX program, of a 12 m 

long beam with I-shaped-cross-sectional and using the materials investigated in the previous chapters. 

The proposed I beam is flexurally reinforced by prestressed glass fibre reinforced polymer (GFRP) and 

steel strand and made of Steel Fibre Reinforced Self-Compacting Concrete (SFRSCC) to suppress the 

steel stirrups. One characteristic of GFRP is its linear elastic behaviour which can lead to brittle failure of 

beams. In general, the opposite behaviour is expected by prestressing these elements which increases 

the beam's ductility. Moreover, aids to increase the shear capacity of the members and control the crack 

width. 

The GFRP bars are immune to corrosion and can be positioned with a small concrete cover in the structure 

whereas the steel strand needs higher concrete cover to avoid corrosion. In case of fire occurrence, the 

steel strand assures the necessary flexural strengthening of the beams if GFRP bars become ineffective. 

The numerical results obtained using the hybrid model will be compared to the results of two other 

developed models using different longitudinal reinforcements: the traditional steel reinforcement and only 

using GFRP reinforcement. For this purpose, the finite element mesh, load, support conditions and 

material properties used in the numerical simulation are described in detail. 

Additionally, the influence of the GFRP-SFRSCC bond conditions on the force versus deflection at mid-

span of SFRSCC I shaped cross-sectional beams reinforced only with GFRP is assessed by carrying out 

two simulations: assuming the bond-slip equation (23) with the parameters indicated in Table 8 for series 

C25LB200 and assuming perfect bond between the GFRP and the surrounding concrete. 

 

6.1. Numerical Simulations  

 

The hypothetical developed case study concerns the potential use of I-shaped-cross-sectional in different 

structures, but in this dissertation, the study focuses on the application in office buildings. Figure 50 and 
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Figure 51 shows the case study, the proposed structural application of the beam and its geometry, and 

few examples of its use in buildings. 

 

 

 

(a) (b) 

 

 

(c) (d) 

Figure 50 – Proposed I beam and applications: (a) Geometry of the beam, (b) Example 1, (c) Example 2, (d) Example 3. 
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(a) (b) 

Figure 51 – Hypothetical case study: (a) Structural application of the beam, (b) Section A-A’. 

 

The beam is subjected to different load cases and combinations. For the permanent load was considered 

the self-weight of the beam, the self-weight of a slab used in office buildings and the slab covering. For 

the live load was considered the uniformly distributed load for office buildings, see Table 15. Note that 

the beam was designed according to Eurocode 1, part 1-1 (Actions on structures/General Actions) and 

Eurocode 0 (Annex A1). Eurocode 1 recommends that uniformly distributed loads for office areas 

(Category B) range between 2 and 3 𝑘𝑁 𝑚2, Figure 52a, and Eurocode 0 (Annex A1) recommends the 

values of ψ factors for buildings, Figure 52b. The detailed beam design is given in the Annex B. 

 

Table 15 – Combination of actions used in the beam design. 

 

 

 

Permanent Loads: 

Live Loads: 

729,73 529,74

Combination of actions
Uniformly distributed load (kN/m) Máx. Bending moment (kN.m)

Ultimate Limit States Serviceability Limit States

1069,92 756,54

826,92 -

42,03

-

Ultimate Limit States 

Characteristic Load Combination

Frequent Load Combination
Quasi-permanent Load Combination

Serviceability Limit States

59,44

45,94

40,54 29,43

𝑔𝑘,𝑏𝑒𝑎𝑚=3,03𝑘𝑁 𝑚  𝑔𝑘,𝑠𝑙𝑎𝑏=18𝑘𝑁 𝑚  𝑔𝑘,𝑠𝑙𝑎𝑏.𝑐𝑜𝑣𝑒𝑟𝑖𝑛𝑔=3𝑘𝑁 𝑚 

 𝑘 = 18 𝑘𝑁 𝑚
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(a) (b) 

Figure 52 – Uniformly distributed loads and ψ factors for office buildings, respectively, according to: (a) Eurocode 1, (b) 

Eurocode 0. 

 

This section also presents the finite element models used in the numerical simulations carried out in the 

context of the case study. The description of the FE models includes details of the adopted mesh, 

boundary conditions, and the respective constitutive laws and parameters that define the models. 

A total of five differently reinforced I-shaped cross-sectional SFRSCC beams were simulated. One beam 

was longitudinally reinforced with passive conventional steel bars (traditional flexural reinforcement), 

Figure 53a, two were reinforced with prestressed steel strand and GFRP bars, Figure 53b and Figure 53c, 

one reinforced with passive conventional steel bars and prestressed GFRP bars, Figure 53d, and another 

with only prestressed GFRP bars, Figure 53e. 
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(a) (b) 

  

(c) (d) 
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(e) 

Figure 53 – Numerically simulated beams: (a) A_10ɸ20, (b) B1_6ɸ12_ɸ15, (c) B2_4ɸ12_ɸ15, (d) B3_5ɸ12_3ɸ10, 

(e) C_6ɸ12. 

 

The geometry of the finite element mesh used for the beam simulation was the same for all the different 

reinforced beams. Figure 54 shows an example of the implemented mesh for the beam. Based on the 

symmetry of the structure, only half of the beam was considered in the simulation. 

For the simulation of the steel fibre reinforced self-compacting concrete (SFRSCC) 8-node Serendipity 

plain stress FE with 2x2 Gauss-Legendre integration scheme was used. The prestressed steel strand and 

GFRP bars were discretized by 3-node Cable 2D elements with 2 Gauss-Legendre integration points. 

Additionally, 3-noded Embedded cable 2D elements with 2 points Gauss-Legendre integration scheme 

were employed for simulating the conventional and passive steel bars. The flexural reinforcement 

elements were assumed to have a perfect bond with the surrounding concrete elements. 
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Figure 54 – Geometrical details of the hybrid SFRSCC beam reinforced by prestressed steel strand and GFRP bars 

(dimensions in mm). 

 

According to the real shape of the developed I beam, Figure 50a, the thickness of the plain stress FE 

variation was implemented to the nodes at the same horizontal level with respect to its height. For 

example, 100 mm thickness was assigned to the nodes located at 160 mm from the bottom of the beam 

up to 740 mm (entire beam web), and 220 mm thickness was assigned to all nodes of the beam flange. 

The non-linear material model “NLMM_104” was used to simulate the behaviour of the SFRSCC and the 

values assumed for the simulation of this material were derived from the numerical model validation 

previously presented for shallow beams, Table 12. To simulate the behaviour of the longitudinal 

reinforcement the “NLMM_201” constitutive model was used. The parameters used to simulate 

conventional steel behaviour were the same used in the modelling of the C_10_45 shallow beam, 

presented in Table 13. The values of the constitutive model of the GFRP bars and the steel strand are 

indicated in Table 7 and Table 16, respectively. 

 

Table 16 – Values of the parameters of the steel strand constitutive model. 

 

 

1 195

Diameter Third branch 

exponent

Young's modulus

15 0,007991 1558,3 0,029 1664,15 0,05 1770

(𝑚𝑚)
𝜉𝑠𝑦 𝜎𝑠𝑦 𝑀𝑃𝑎 𝜉𝑠 𝜎𝑠 𝑀𝑃𝑎 𝜉𝑠𝑢 𝜎𝑠𝑢 𝑀𝑃𝑎 (𝐺𝑃𝑎)
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The steel strand and GFRP bars discretized by Cable 2D finite elements were incorporated with the 

prestress effect of reinforcements by using a thermal loading condition. In these simulations was adopted 

a prestress level of 75% of the steel strand yielding stress (𝑓𝑠𝑦 = 1558.3 𝑀𝑃𝑎) and a prestress level 

of 30% of the GFRP bars ultimate tensile stress (𝑓𝑓𝑢 = 945.56 𝑀𝑃𝑎). The required temperature 

variation to exhibit the desired amount of pre-strain in the reinforcement was -600ºC for the steel strand 

and -630ºC for the GFRP bars.∆T 

 

6.2.1. Results and discussion 
 

For the purpose of establishing a comparison between all the I beam studied, the serviceability limit states 

(deflection limitation, stress limitation and crack control) were calculated according to the 

recommendations from the Eurocode 2, part 1-1. 

In relation to the deflection limit, Eurocode 2, part 1-1, recommends for serviceability limit states a 

deflection non-superior to L/250, where L is the total length of the structure. Therefore, for a loaded 

length of 12 m, the deflection limit is 48 mm. Figure 55 shows the force-deflection response of the I 

beam obtained from all the numerical simulations (assuming perfect bond between the reinforcement 

and the surrounding concrete), where force corresponds to the total uniformly distributed load on the 

span, and deflection corresponds to the mid-point of the span.  

Table 17 presents the respective values of the load-carrying capacity obtained for each beam analysed. 
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Figure 55 – Force-deflection response of the developed numerical simulations and deflection limitation for serviceability limit 

states. 

 

In Figure 55, it is evident that there was a substantial increment in the load-carrying capacity when the 

post cracking strength increases. The conventional steel reinforced beam presented premature concrete 

crack opening but higher load carrying capacity at serviceability limit states and steel yield initiation 

compared to all other simulations. The beams with prestressed reinforcement showed ductility 

performance, which did not happen with the beam with conventional reinforcement. 

 

Table 17 – Load carrying capacity at serviceability limit states. 

I shaped cross-sectional SFRSCC I beam  Deflection (mm) Service Load (kN) 

A_10ɸ20 

 

 

B1_6ɸ12_ɸ15  

B2_4ɸ12_ɸ15  

B3_5ɸ12_3ɸ10  

C_6ɸ12  

  

 

From the analysis of Table 17, is possible to realize that the service load of the beam with traditional 

reinforcement was 41.3% higher than the best force-deflection response of all other numerically simulated 
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beams (B1_6ɸ12_ɸ15). However, the increase in the service load by increasing the prestress level is 

notable. For example, the service load-carrying capacity of the beam B1_6ɸ12_ɸ15 was 26% higher 

than the service load of the beam reinforced with passive conventional steel reinforcement and 

prestressed GFRP bars (B3_5ɸ12_3ɸ10). 

Hereafter, as a means of comparison, the text will only present the results of the conventional solution 

(A_10ɸ20) and the beam simulation that provided the best results (B1_6ɸ12_ɸ15). Figure 56 shows 

the visualization of the deflection at mid-span obtained for the serviceability limit states of those different 

beam simulations. 

 

 

(a) 

 

(b) 
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Figure 56 – Deflection visualization of the numerically simulated beams: (a) A_10ɸ20, (b) B1_6ɸ12_ɸ15 (displacements 

in mm). 

 

Is important to note that Figure 56 depicts the evolution of the displacements in y (X3) direction. The mid-

span deflection of the beams is the deflection limit (48 mm) to which the service load was presented 

previously. 

In relation to the stress limitation, Eurocode 2, part 1-1, suggest that under service load conditions the 

stress on FRC and steel reinforcements shall be limited in order to reduce the probability of concrete 

cracking and avoid unacceptable effects on the functionality of the structure. Thus, Eq.(30) shall be used. 

 

𝜎𝑐
𝑘 < 0.6 ∗ 𝑓𝑐𝑘 (30) 

 

Where 𝜎𝑐
𝑘 is the compressive stress limitation of concrete in the beam determined for the characteristic 

load combination, and 𝑓𝑐𝑘 is the characteristic compressive strength of the concrete. 

 

As the 𝑓𝑐𝑘 is 91.22 MPa, replacing this value in Eq.(30), comes:  

 

𝜎𝑐
𝑘 < 0.6 ∗ 91.22 = 54.73 𝑀𝑃𝑎 (31) 

 

For the quasi-permanent combination of actions, Eq.(32) shall be applied. 

 

𝜎𝑐
𝑞 < 0.45 ∗ 𝑓𝑐𝑘 (32) 

 

𝜎𝑐
𝑞 < 0.45 ∗ 91.22 = 41 𝑀𝑃𝑎 (33) 
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If Eq.(30) is verified, it indicates that longitudinal cracking of the beam is unlikely to occur. In the other 

hand, if Eq.(32) is accomplished it represents that creep linearity is ensured, if not, a nonlinear creep 

should be considered. 

 

To prevent inelastic deformations of the steel longitudinal reinforcements, Eq. (34) shall be used. 

 

𝜎𝑠
𝑘 < 0.8 ∗ 𝑓𝑦𝑘 (34) 

 

Where 𝜎𝑠
𝑘 is the steel stress determined for the characteristic load combination of actions. 

 

As the 𝑓𝑦𝑘 is 500 MPa, replacing this value in Eq.(34), comes: 

 

𝜎𝑠
𝑘 < 0.8 ∗ 500 = 400 𝑀𝑃𝑎 (35) 

 

Under the characteristic combination of actions, the stress in the prestressing reinforcements is controlled 

by, Eq.(36) and Eq.(37). 

 

𝜎𝑝
𝑘 < 0.75 ∗ 𝑓𝑝𝑘 (36) 

 

𝜎𝑝
𝑘 < 0.75 ∗ 1770 = 1327.5 𝑀𝑃𝑎 (37) 

 

𝜎𝑓
𝑘 < 0.75 ∗ 𝑓𝑓𝑢 (38) 

 

𝜎𝑓
𝑘 < 0.75 ∗ 945.56 = 709.17 𝑀𝑃𝑎 (39) 
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Table 18 presents the stresses in the SFRSCC, steel strand, GFRP bars and conventional steel bars at 

the critical sections of all the numerically simulated I beams, for the characteristic load combination at 

the serviceability limit states. 

 

Table 18 – Maximum stresses for serviceability limit states. 

I shaped cross-sectional SFRSCC I beam 
SFRSCC 
compressive 
stress (MPa) 

Steel Strand 
tensile stress 
(MPa) 

GFRP tensile 

stress (MPa) 

Conventional 
steel tensile 
stress (MPa) 

A_10ɸ20  − −  

B1_6ɸ12_ɸ15    − 

B2_4ɸ12_ɸ15    − 

B3_5ɸ12_3ɸ10  −   

C_6ɸ12  −  − 

     

 

According to Table 18 the maximum (40.8 MPa) and minimum (27.8 MPa) SFRSCC compressive stress 

(40.8 MPa) was obtained for the beam reinforced with conventional steel (A_10ɸ20) and for the beam 

with prestressed GFRP bars and passive conventional steel strand (B3_5ɸ12_3ɸ10), respectively. Is 

important to note that these compressive stresses occur in the face of the top flange of the beam at the 

mid-span. Also, is possible to realize that the analysed sections did not reach the compressive stress 

limitation for serviceability limit states. For example, the compressive stress obtained for the beam with 

conventional steel reached only 74.5% of the compressive stress limitation. In comparison, the beam with 

prestressed GFRP bars and Steel strand (B1_6ɸ12_ɸ15) reached only 58 % of the maximum 

compressive stress for serviceability limit states. 

The maximum tensile stress obtained in the GFRP bars (C_6ɸ12 beam) is far below the GFRP tensile 

strength and 35.6 % below the stress limitation for prestressing reinforcements. This situation did not 

happen to the beam with prestressed GFRP and passive conventional steel bars, as the conventional steel 

bars ruptured. The stresses in the beam simulation that provided the best results (B1_6ɸ12_ɸ15) were 

41.7% below the maximum stress for this type of prestressing reinforcements, Eq.(38). 

In relation to the steel strand tensile stress is important to mention that in both beams B1_6ɸ12_ɸ15 

and B2_4ɸ12_ɸ15 the limit concerning the stress for the prestressing reinforcements in Eq.(37) was 
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exceeded, but still did not reach the steel strand tensile strength. In this case, the unacceptable level of 

cracking or deformation of the beam can’t be predicted. 

Figure 57 depicts the stresses in the SFRSCC in the x-direction obtained for the serviceability limit states. 

The higher tensile stresses in the SFRSCC occurred in the face of the bottom flange of the beams at mid-

span. 

 

 

(a) 

 

(b) 

Figure 57 – Concrete stresses visualization of the numerically simulated beams: (a) A_10ɸ20, (b) B1_6ɸ12_ɸ15. 
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For the crack control, Eurocode 2 adopts a cracking serviceability criterion in the form of limiting the crack 

width, 𝑤𝑑,to a nominal limiting value, 𝑤𝑙𝑖𝑚, see Eq.(40). This cracking serviceability criterion should be 

verified to assure that the requirements concerning functionality, durability and appearance are met. 

 

𝑤𝑑 < 𝑤𝑙𝑖𝑚 (40) 

 

Where the variable 𝑤𝑑 represents the design value of crack width at the concrete member surface and 

is determined for the appropriate combination of actions. The nominal crack width limit at the concrete 

surface, 𝑤𝑙𝑖𝑚, must be chosen based on the design situation or specified in the project. 

For this specific case study was considered that the exposure to which the beams were subjected was 

moderate humidity, and according to Eurocode 2, corresponds to the XC3 class designation, Figure 58a. 

This exposure class recommends a nominal limit value of crack width, 𝑤𝑙𝑖𝑚, for serviceability limit states 

of 0.3 mm, Figure 58b. 

 

  

(a) (b) 

Figure 58 – Eurocode 2, part 1-1 design recommendations: (a) exposure classes, (b) recommended values of 𝑤𝑙𝑖𝑚 for the 

exposure classes. 

 

Table 19 summarizes the maximum crack width at the mid-span of the beams for the characteristic 

combination of actions at the serviceability limit states. The crack width was obtained by multiplying the 

crack normal strain in the direction of the beam’s axis by the crack band width (values from the numerical 

analysis). 



 P a g e  | 85 

 

UNIVERSITY OF MINHO  Diogo Lourenço Fernandes 

 

Table 19 – Maximum crack width for serviceability limit states. 

I shaped cross-sectional SFRSCC I beam  Crack width (mm) 
Máx. Crack width 

(mm) 

A_10ɸ20   

B1_6ɸ12_ɸ15   

B2_4ɸ12_ɸ15   

B3_5ɸ12_3ɸ10   

C_6ɸ12   

 

The maximum crack width (0.091 mm) was obtained in the beam reinforced with prestressed GFRP bars 

and passive conventional steel bars, whereas the minimum crack width (0.03 mm) was obtained in the 

beam reinforced with conventional steel bars. However, the nominal limit value of crack width for 

serviceability limit states was not reached. 

Figure 59 displays the crack pattern obtained from the A_10ɸ20 beam and the B1_6ɸ12_ɸ15 beam, 

where the maximum computed crack width was about 0.03 mm and 0.055 mm in Figure 59a and Figure 

59b, respectively, in the mid-span zone of the finite element mesh. 

 

 

(a) 

 

(b) 

Figure 59 – Crack pattern visualization of the numerically simulated beams: (a) A_10ɸ20, (b) B1_6ɸ12_ɸ15. 
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From Figure 59 is possible to observe some crushing around the support and closely spacing cracks 

appearing progressively. In the beam reinforced with conventional steel the shear cracks were more 

pronounced than the flexural cracks. Also, the shear cracks in this beam were starting to being 

progressively converted in diagonal shear ones, which leaded to shear failure cracks propagated along 

the longitudinal reinforcements in one extremity of the beam and towards the applied load in the other 

extremity. On the other hand, the hybrid beam presented flexural cracks which probably leaded to flexural 

failure. This better performance behaviour was due to the application of prestress in the reinforcement 

which increased the bridging effect of a high number of steel fibres across the cracks. 

 

6.2.2. Influence of the GFRP-SFRSCC bond conditions on force-deflection response 

of I-shaped cross-sectional beams 
 

To assess the influence on the bond conditions between the GFRP bars and the SFRSCC in relation to 

the force versus slip response of I beams flexurally reinforced with GFRP bars, a material nonlinear 

analysis with FEMIX was carried out with the same numerically simulated beam represented in Figure 

53d. The difference in this analysis was that passive GFRP bars were used instead of prestressed ones. 

The geometry of the finite element mesh used in this numerical simulation is depicted in Figure 60. 

 

 

Figure 60 – Geometrical details of the SFRSCC beam reinforced with passive GFRP bars (dimensions in mm). 
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For the simulation of the SFRSCC 8-node Serendipity plain stress FE with 2x2 Gauss-Legendre integration 

scheme was used. The GFRP bars were discretized by 3-node Embedded cable 2D elements with 2 points 

Gauss-Legendre integration scheme. Two simulations were carried out assuming the bond-slip equation 

(23) with the parameters indicated in Table 8 for the C25LB200 series (SFRSCC cover of 25 mm and 

200 mm of bond length) and assuming perfect bond between the GFRP bars and the surrounding 

concrete. Is of major importance to note that the local bond law used in this simulation was determined 

for a different GFRP bar diameter (Φ5 mm) and concrete cover thickness (25 mm). The adopted diameter 

in the I beam simulation (Φ12 mm) was 2.4 times higher than the adopted for the series local bond law 

determination and the concrete cover thickness (35 mm) was 1.4 times higher. However, the SFRSCC 

properties used in the simulations were the same used in the pullout bending tests for the determination 

of the local bond laws. This differences in the modelling could generate discrepancies in the results. The 

interface finite elements used to simulate the bond behaviour between the GFRP bars and the surrounding 

SFRSCC were modelled by 4-nodes-2D-interface elements with 2 Gauss-Legendre integration points. 

Figure 61 shows the load versus mid-span deflection at the last load combination for both simulations, 

one allowing the slip between GFRP bars and surrounding SFRSCC and the second assuming perfect 

bond of the interaction GFRP-SFRSCC. 

 

 

Figure 61 – Load versus mid-span deflection assuming bond slip and perfect bond between GFRP bars and surrounding 

SFRSCC. 

 

As mentioned before, the difference between assuming bond slip and perfect bond in the simulations was 

minimum and because of that was concluded that the bond conditions in this situation do not have 
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relevant effect on the load carrying capacity of the simulated beams. Furthermore, the numerical analysis 

revealed that bond conditions did not affect the maximum crack width and stresses of the beams. This 

conclusion could be misled because of the bond law assumed in the bond-slip simulation, which could 

be studied in future works. 
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Chapter 7 

7. Summary and Conclusions 

 

The present dissertation aimed to study a new generation of structural reinforcement systems for concrete 

structures by using high-performance materials, especially the Steel Fibre Reinforced Self-Compacting 

Concrete (SFRSCC) and Glass Fibre Reinforced Polymer (GFRP). The advantages of prestressing the GFRP 

bars and Steel Strand in the design reinforcement of structural elements were also investigated. A major 

focus of this work was the development, validation, and implementation of constitutive models for the 

materials using analytical and numerical tools. 

In this scope, chapter one was dedicated to the establishment of the dissertation by highlighting the 

importance and objective of the study. 

Chapter two laid the groundwork for some knowledge about the materials behaviour used in the 

investigation process carried out in this dissertation. One braided composite rod (BCR) that composes 

the 3D-SRT (3-Dimensional System Reinforcement Textile) was studied in this dissertation, here 

mentioned as GFRP bar. Besides, some information was retained about the bond behaviour between FRC 

and FRP bars, the influence of steel fibres in FRC, and the shear capacity of FRC beams. For example, 

the bond performance influences the load carrying capacity of a reinforced element and the parameters 

that influence the pullout bending tests are essentially the concrete cover thickness, anchorage length, 

bar diameter and bar surface treatment. 

Chapter three and four was focused on the evaluation of bond behaviour between GFRP bars and 

SFRSCC. The experimental program showed that the pullout force increases almost linearly with the 

anchorage length and the values of the average bond stress (𝜏̅𝑚𝑎𝑥) decreased with the increase of 

anchorage length. Furthermore, the experimental program showed that the concrete cover thickness had 

no influence on the bond relationship. In chapter four was developed an analytical and numerical model 

with the FBL and FEMIX computer programs, respectively, to determine the bond-slip law for the poullout 

bending tests. Those approaches were compared and validated with the experimental results and it is 

important to note that they were capable of simulating with good accuracy the pullout force versus loaded 

end slip for all specimen series tested. 
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Chapter five was one of the most important chapters of the dissertation because in this chapter was 

determined the constitutive models of the concrete, conventional steel and GFRP. The validation of the 

numerical models of shallow beams based on previous experimental work allowed the numerical 

simulation of bending tests of I beams in chapter six. The use of the software GID in the beams modelling 

was, with no doubt, very useful because it allowed the creation of the geometry of the numerical model, 

mesh generation and visualization of the analysis with precision and easiness. The numerical force-

deflection results of the shallow beams failing in bending was predicted with reasonable accuracy. In the 

last part of the chapter the beams were numerically simulated with different longitudinal reinforcement 

(GFRP and Prestressed steel wires) in order to analyse its performance. It can be said that fibre reinforced 

beams present higher load carrying capacity and the energy dissipation decreases slowly, and the 

application of prestress in the beam’s reinforcements provide significant increase in the load carrying 

capacity at serviceability limit states. 

In chapter six it was developed a hypothetical case study on using I-shaped-cross-sectional beams with 

long span in office buildings. The I shaped-cross-section was adopted for the beams in order to optimize 

their flexural performance. Five differently reinforced beams were numerically simulated. The behaviour 

of the beams A_10ɸ20 and B1_6ɸ12_ɸ15 deserved major attention because demonstrated better 

performance and for comparison purposes. The service load of the beam with traditional reinforcement 

was 41.3% higher than the force-deflection response of the B1_6ɸ12_ɸ15 beam. The beams with 

prestressed reinforcement showed ductility performance, which did not happen with the beam with 

conventional reinforcement. In relation to the serviceability limit states the compressive stress obtained 

for the beam A_10ɸ20 reached 74.5% of the compressive stress limitation whereas the beam 

B1_6ɸ12_ɸ15) reached only 58 %. The crack patterns showed potential shear failure of the beam 

reinforced with conventional steel and potential flexural failure of the beam reinforced with prestressed 

GFRP bars and steel strand. 

The analysis on the influence of the GFRP-SFRSCC bond conditions on force-deflection response of I-

shaped cross-sectional beams showed no relationship. 
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APPENDIX A 

Numerical modelling using the FEMIX-GID software 

 

To start the simulation of the beam is necessary to introduce the data related to the beams that define 

its geometry, such as the vertices of the beam and the intersection points between the faces of the beam 

and the longitudinal reinforcement (command: Geometry → Create → Point or Straight line). 

The concrete and steel surfaces were created after the main points of the beam’s geometry had been 

defined, see Figure 62. 

 

 

 

Figure 62 – Creation of points, lines, and surfaces for A_6_0 series by using points. 

 

The area that defines the rectangular surface of the concrete was delimited by four points in the extreme 

vertices of the beam. To identify the top (tensile zone) and bottom (compression zone) longitudinal steel 

reinforcement was necessary to create two reference lines using two points that allowed the creation of 

surfaces between the reinforcement and the surrounding concrete. To distinguish and characterize the 

materials used in the simulations, SCC and Conventional Steel in this example were discretized by layers 

as well as the top and bottom steel reinforcement (commands: Layers → Create a new layer; Select the 

layer and click with the right button of the mouse → Send to → Points, Lines or Surfaces), as shown in 

Figure 63. A poorly defined geometry of the structure or the information about the intervening materials 

around it will cause issues when creating the numerical mesh and the future analysis. This first phase is 

probably the most important for the numerical modelling. 



 P a g e  | 95 

 

UNIVERSITY OF MINHO  Diogo Lourenço Fernandes 

 

 

 

 

 

 

 

Figure 63 – Creation and association of layers to the materials. 

 

After defining all the geometry of the beam and the layers that characterize each material, the next step 

was to create the finite element mesh with an intermediate level of refinement that thought to be 

acceptable. 

The concrete used in the beams was simulated by 8-noded Serendipity plane stress finite elements with 

3x3 Gauss-Legendre integration scheme, Figure 64, and quadratic 3-noded Embedded cable 2D with two 

points Gauss-Legendre integration scheme was used to simulate the longitudinal reinforcements. Is 

important to note that the steel bars were assumed to be perfectly bonded and embedded into the 

surrounding concrete.  

 

 

 

 

Figure 64 – Serendipity 8-node finite element [8]. 

 

This type of elements are associated to the mesh using the quadratic function available in GID as shown 

in Figure 65, (command: Mesh → Quadratic type → Quadratic). If the user pretends to associate less 

nodes to the element, the option is to use the Normal function, which is associated with 4-node finite 

elements (for concrete) and 2-node finite elements (for reinforcement). 
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The next step for the construction of the mesh is to define the number of finite elements. To introduce 

the intermediate level of refinement pretended to the mesh, it is necessary to attribute the number of 

cells and the cell size to create the elements (command: Mesh → Structured → Surfaces or Lines → 

Assign number of cells or Assign size). The function Assign number of cells defines the number of cells 

that the element is pretended to be divided and Assign size defines the size of the previous divided cell, 

in millimetres, Figure 66. 

 

 

 

 

 

 

 

 

 

Figure 65 – Finite element number of integration points selection. 

 

 

 

 

 

 

 

 

Figure 66 – Attribution of the number of cells and corresponding size to define the finite elements. 
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For the creation of the mesh and using the Assign size function firstly is necessary to select the surface 

for concrete and the lines for the reinforcement. After that, press ESC and introduce the value for the 

lateral dimension of a finite element in millimetres. Subsequently press “Assign” and select the element 

to assign the chosen dimension doing the same process for each surface or line. The process for using 

the function Assign number of cells is similar to the one described previously, except that the imputed 

values refer to the number of cells that will divide the selected element. In the case of surfaces (Self-

compacting concrete in this example) the commands to used are Mesh → Structured → Surfaces → 

Assign number of cells or Assign size and for lines (conventional steel reinforcement or GFRP) the 

commands are Mesh → Structured → Lines → Assign number of cells or Assign size. 

Once the creation of the finite elements is concluded the next step is to generate the mesh (command: 

Mesh → Generate mesh). It is of high importance to collapse the mesh after its generation because there 

is a possible overlap of the nodes of the concrete with the nodes of the reinforcement (command: Mesh 

→ Edit mesh → Collapse → Mesh).Figure 67 shows how the commands are introduced in the software 

for the generation of the mesh and its collapsing. 

 

  

(a) (b) 

Figure 67 – Creation of the finite element mesh: (a) Generate the mesh, (b) Collapse the nodes of the mesh. 

 

The example of the created finite element mesh for beams reinforced with 6 mm diameter longitudinal 

steel bars and without steel fibres in the self-compacting concrete (A_6_0) is depicted in Figure 68. After 

the creation of the mesh is necessary to introduce the information concerning the characteristics of the 

materials, the supports, the prescribed loads/displacements, and existing combinations.  
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Figure 68 – Finite element mesh used for the simulation of A_6_0 series (dimensions in mm). 

 

The numerical analysis is possible due to different structural calculation software available in GID. To 

choose the software to perform the calculations of the structure that has been modelled the (Problem 

type) must be defined. In the context of the present dissertation, the software chosen was FEMIX 

(command: Data → Problem type → FEMIX), see Figure 69. 

 

 

 

 

 

 

 

Figure 69 – Calculation software used along with GID. 

 

In relation to the element properties assumed in the simulation of A_6_0 series two types of elements 

were used: Plane stress quad elements for concrete and Embedded cable 2D elements for the 

reinforcement. It was necessary to introduce the beam thickness (350 mm) to correctly define the plane 
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stress quad element and the cross-section area of the longitudinal reinforcement (in this simulation the 

total cross-section area of the top and bottom steel reinforcement was equal: 84.82 𝑚𝑚2) to define the 

Embedded cable 2D elements. Figure 70 shows how the different properties were attributed to the 

elements (command: Data → Conditions → Element Properties). Is of major importance to ensure that 

all the element properties have been correctly assigned at the end of entering all the values for all the 

layers (command: Data → Conditions → Element Properties → Draw → Colours), see Figure 71. 

 

 

 

(a) (b) 

Figure 70 – Introduction of the mesh element properties: (a) Command, (b) Imputed element properties. 

 

Figure 71 – GID graphic visualization of the element properties defined for each layer. 
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To input the information about the supports used in simulation of the beam bending test is necessary to 

select the finite element mesh node where the support is placed and define in which direction the 

movement is restrained (command: Data → Conditions → Supports → Selection of the node → Assign). 

In this simulation was considered a roller support at the symmetry axle (restrained in x and z) of the slab 

strip and a pinned support (restrained in x and y) at 125 mm from the lateral side of the slab, as shown 

in Figure 72. 

 

Figure 72 – Supports of the shallow beams. 

 

To assign a load or displacement to a finite element mesh node is necessary to input the values in the 

desired direction (x,y or z) and select the correct mesh node. The information on how loads or prescribed 

displacements are introduced to GID is depicted in Figure 73 (command: Data → Conditions → Loads 

→ Input the value → Selection of the node → Assign). 

It was also necessary to characterize the concrete and the reinforcement in the tests. To simulate the 

post-cracking behaviour of the concrete, a quadrilinear tensile-softening diagram available in the software 

was used and the Fracture Mode I parameters were defined. 
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Figure 73 – Loads or prescribed displacements. 

 

The constitutive model used for the simulation of the concrete behaviour was the NLMM104 and Figure 

74 shows how this model is chosen in the software (command: Data → Materials → Continuous 

Materials → NLMM104 Concrete → Input the Generic Properties → Input the Fracture Mode I Properties 

→ Selection of the material → Assign). 
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Figure 74 – Concrete properties used in the simulation of the A_6_0 shallow beams series. 

 

The constitutive model used for the simulation of the steel behaviour was the NLMM201 and Figure 75 

shows how this model is chosen in the software (command: Data → Materials → Continuous Materials 

→ NLMM201 Steel → Input Properties → Selection of the material → Assign). 

 

 

 

 

 

 

 

 

Figure 75 – Steel properties used in the simulation of the A_6_0 shallow beams series. 
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A crucial aspect of a numerical simulation is the verification of the constitutive model used to define the 

materials (command: Data → Materials → Continuous Materials → Draw → Colours), as shown in the 

example depicted in Figure 76. 

 

 

Figure 76 – Example of GID graphic visualization of the assigned materials constitutive models in the C_10_0 shallow 

beams series. 

 

The final step before performing the numerical simulation was the definition of the load cases and the 

combinations that better suited the experimental program. To introduce the load cases is necessary to 

define the name of the load to be applied and indicate whether it is intended to apply the self-weight of 

the structure (command: Data → Load Cases → Load Title→ Accept). For the introduction of the 

combinations is necessary to follow the command (Data → Combinations → Combination Title → 

Number of Increment un the Combination → Number of Load Cases → Load Factor → Add → Accept), 

see Figure 77. In all the numerical simulations the load was applied by direct displacement—control at 

the loaded point (Node number 653, degree of freedom Y) and the Newton-Raphson algorithm was used 

(command: Data → Main Parameters → Nonlinear Analysis→ Arc Length), Figure 78. 
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(a) (b) 

Figure 77 – Introduction of load cases and combinations to the numerical model: (a) Load Cases, (b) Combinations. 

 

Figure 78 – Introduction of the Newton-Raphson method and Arc-length technique to the numerical model. 

 

After going through all the steps described previously, it is possible to proceed to calculate the structure 

behaviour using the software FEMIX, Figure 79. 
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Figure 79 – Numerical model calculation process. 
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APPENDIX B 

I-shaped cross-sectional beam design 

 

Permanent Loads 

I beam deadweight:  

𝑔𝑘,𝑏𝑒𝑎𝑚 = 25𝑘𝑁 𝑚3⁄ ∗ 𝐴𝑏𝑒𝑎𝑚 = 3.03 𝑘𝑁 𝑚 (41) 

 

Where 𝐴𝑏𝑒𝑎𝑚 = 0.12 𝑚2 is the area of the cross section of the studied I beam. 

 

Office slab deadweight:  

𝑔𝑘,𝑠𝑙𝑎𝑏 = 3𝑘𝑁 𝑚2⁄ ∗ 𝐿𝑖𝑛𝑓𝑙𝑢𝑒𝑛𝑐𝑒 = 18 𝑘𝑁 𝑚 (42) 

 

Where 𝐿𝑖𝑛𝑓𝑙𝑢𝑒𝑛𝑐𝑒 = 6 𝑚 is the loading influence width of the slab supported by the beam. 

 

Slab covering deadweight:  

𝑔𝑘,𝑠𝑙𝑎𝑏𝑐𝑜𝑣. = 0.5 𝑘𝑁 𝑚2⁄ ∗ 𝐿𝑖𝑛𝑓𝑙𝑢𝑒𝑛𝑐𝑒 = 3 𝑘𝑁 𝑚 (43) 

 

Live loads 

Office buildings live load: 

 𝑘 = 3 𝑘𝑁 𝑚2⁄ ∗ 𝐿𝑖𝑛𝑓𝑙𝑢𝑒𝑛𝑐𝑒 = 18 𝑘𝑁 𝑚 (44) 

 

Where 𝐿𝑖𝑛𝑓𝑙𝑢𝑒𝑛𝑐𝑒 = 6 𝑚 is the loading influence width of the slab supported by the beam. 
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Ultimate Limit States 

In relation to the ultimate limit states (ULS) the characteristic load combination is given by Eq.(45). 

𝑃𝑈𝐿𝑆,𝑘 = 1.35 ∗ Σ𝑔𝑘 + 1.5 ∗  𝑘 (45) 

 

Then, assuming the previous values, the Eq.(45) leads to the uniformly distributed load in Eq.(46). 

𝑃𝑈𝐿𝑆,𝑘 = 1.35 ∗ (3.03 + 18 + 3) + 1.5 ∗ 18 = 59.44 𝑘𝑁 𝑚 (46) 

 

To determine the maximum acting design bending moment at mid-span for both ultimate and 

serviceability limit states, Eq.(47) is used. 

𝑀𝑈𝐿𝑆,𝑘 =
𝑃𝑈𝐿𝑆,𝑘 ∗ 𝐿𝑏𝑒𝑎𝑚 

2

8
 

(47) 

 

Where 𝐿𝑏𝑒𝑎𝑚 = 12 𝑚 is the loaded length of the beam. 

 

Resulting a maximum acting design bending moment at mid-span of: 

𝑀𝑈𝐿𝑆,𝑘 =
59.44 ∗ 122

8
= 1069.92 𝑘𝑁 ∗ 𝑚 

(48) 

 

The frequent load combination is given by Eq.(49). 

𝑃𝑈𝐿𝑆,𝑓𝑟 = 1.35 ∗ Σ𝑔𝑘 + 1.5 ∗ 𝜓1 ∗  𝑘 (49) 

 

𝑃𝑈𝐿𝑆,𝑓𝑟 = 1.35 ∗ (3.03 + 18 + 3) + 1.5 ∗ 0.5 ∗ 18 = 45.94 𝑘𝑁 𝑚 (50) 

𝑀𝑈𝐿𝑆,𝑓𝑟 =
45.94 ∗ 122

8
= 826.92 𝑘𝑁 ∗ 𝑚 

(51) 
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The quasi-permanent load combination is given by Eq.(52). 

𝑃𝑈𝐿𝑆,𝑞 = 1.35 ∗ Σ𝑔𝑘 + 1.5 ∗ 𝜓2 ∗  𝑘 (52) 

 

𝑃𝑈𝐿𝑆,𝑞 = 1.35 ∗ (3.03 + 18 + 3) + 1.5 ∗ 0.3 ∗ 18 = 40.54 𝑘𝑁 𝑚 (53) 

 

𝑀𝑈𝐿𝑆,𝑞 =
40.54 ∗ 122

8
= 729.73 𝑘𝑁 ∗ 𝑚 

(54) 

 

Serviceability Limit States 

For the serviceability limit states (SLS) the characteristic load combination is given by Eq. (55). 

𝑃𝑆𝐿𝑆,𝑘 = 1.0 ∗ Σ𝑔𝑘 + 1.0 ∗  𝑘 (55) 

 

𝑃𝑆𝐿𝑆,𝑘 = 1.0 ∗ (3.03 + 18 + 3) + 1.0 ∗ 18 = 42.03 𝑘𝑁 𝑚 (56) 

 

𝑀𝑆𝐿𝑆,𝑘 =
42.03 ∗ 122

8
= 756.54 𝑘𝑁 ∗ 𝑚 

(57) 

 

Finally, the quasi-permanent load combination is given by Eq.(58). 

𝑃𝑆𝐿𝑆,𝑞 = 1.0 ∗ Σ𝑔𝑘 + 1.0 ∗ 𝜓2 ∗  𝑘 (58) 

 

𝑃𝑆𝐿𝑆,𝑞 = 1.0 ∗ (3.03 + 18 + 3) + 1.0 ∗ 0.3 ∗ 18 = 29.43 𝑘𝑁 𝑚 (59) 

 

𝑀𝑆𝐿𝑆,𝑞 =
40.54 ∗ 122

8
= 529.74 𝑘𝑁 ∗ 𝑚 

(60) 

 


